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About this book

This installation guide provides instructions for installing and uninstalling IBM
Rational Developer for System z Version 7.1.

This document contains information on the following tasks:
* Preparing for installation

¢ Installing Developer for System z

* Installing required and optional workstation software

+ Installing System z " server tools

* Recognizing known problems and limitations with installation

From here on, the following names are used in this manual:
* IBM Rational Developer for System z is called Developer for System z

* IBM Rational Developer for System z Common Access Repository Manager is called
Common Access Repository Manager, sometimes abbreviated to CARMA

Note: The configuration information found in this document is for IBM Rational
Developer for System z Version 7.1.

Who should read this book

This book is intended for programmers installing and configuring IBM Rational
Developer for System z Version 7.1 client on their workstation. To use this book,
you need to be familiar with the Windows® operating system.

© Copyright IBM Corp. 2000, 2007
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IBM Rational Developer for System z Version 7.1 Installation
Guide

Where to find more information about Developer for System z

This file does not contain information about using Developer for System z. Refer to
the online help for that information.

For information about product problems and limitations, refer to the readme.htm]
file located in the Documents\en directory of the CD IBM Rational Developer for
System z and IBM® Rational® Application Developer Installation CD 1.

See the Library page of the Developer for System z website: http://www-
306.1ibm.com/software/awdtools/devzseries/Tibrary for updated documentation
and troubleshooting information.

Introduction to Developer for System z

Developer for System z has a host component and a workstation client component.
The host component is typically installed by a site’s system programmer and is
transparent to the application programmers. For the remainder of this guide,
unless the host component is specifically called out, the term Developer for System
z will refer to the workstation component of the tool - the graphical user interface
powered by the Eclipse platform.

Developer for System z is a set of development tools that extend the Rational
Application Developer offering which itself is built on the Eclipse platform
(www.eclipse.org). Think of the Eclipse platform as the framework and
infrastructure provider and Rational Application Developer and Developer for
System z as the tool contributors.

IBM Installation Manager

IBM Installation Manager is a program that installs the IBM Rational Application
Developer and Developer for System z product packages on your workstation. It
also updates, modifies, and uninstalls these and other packages that you install. A
package can be a product, a group of components, or a single component that is
designed to be installed with the Installation Manager.

Regardless of which installation method you follow to install Developer for System
z on your workstation, you will use Installation Manager to install the package. An
Installation Wizard is also provided. This wizard guides you through any setup
tasks that are required prior to installing Developer for System z. When the setup
tasks are complete and you are ready to install Developer for System z, the
Installation Wizard launches the Installation Manager for you,.

The Installation Manager is an installation management tool that offers a number
of time-saving features. It helps you install, update, modify, and uninstall product
packages on your computer. It keeps track of what you are about to install, as well
as what you have already installed and what is available for you to install. It
searches for updates so you know that you are installing the latest version of a
package. It also provides tools for managing licenses for the packages it installs,
and for updating and modifying packages.

© Copyright IBM Corp. 2000, 2007 1



There are six wizards in Installation Manager that make it easy to maintain your
package through its lifecycle:

The Install Packages wizard walks you through the installation process. You can

install a package by simply accepting the defaults, or you can modify the default
settings to create a custom installation. Before you install, you are provided with
a complete summary of your selections throughout the wizard. Using the wizard
you can install one or more packages at one time.

The Update Packages wizard searches for available updates to packages you
have installed. An update might be a fix that was released, a new feature, or a
new version of the product. Details of the contents of the update are provided in
the wizard. You can choose whether to apply an update.

The modify Packages wizard modifies certain elements of a package you have
already installed. During your first installation of the package, you select the
features you want to install. If you find later that you require other features, you
can use the modify packages wizard to add them to your package. You can also
remove features, and add or remove languages.

The Roll Back Packages wizard allows you to uninstall updates you have
installed for a product and revert back to a previous version of that product.

The Manage Licenses wizard helps set up the licenses for your packages. Use
this wizard to change your trial license to a full license, to set up your servers
for floating licenses and to select which type of license to use for each package.

The Uninstall Packages wizard removes a package from your computer. You can
uninstall more than one package at a time.

Client Installation requirements

2

To prepare for installation, you need to complete the following activities:

Meeting media requirements

Meeting hardware and software requirements

Meeting media requirements

You must have access to either of the following media to install Developer for
System z on the workstation:

Developer for System z installation CDs:

— IBM Rational Developer for System z and IBM Rational Application Developer
Installation CD 1

— IBM Rational Developer for System z and IBM Rational Application Developer
Installation CD 2

— IBM Rational Developer for System z and IBM Rational Application Developer
Installation CD 3

— IBM Rational Developer for System z and IBM Rational Application Developer
Installation CD 4

— IBM Rational Developer for System z and IBM Rational Application Developer
Installation CD 5

— IBM Rational Developer for System z and IBM Rational Application Developer
Installation CD 6

— IBM Rational Developer for System z and IBM Rational Application Developer
Installation CD 7

— IBM Rational Developer for System z and IBM Rational Application Developer
Installation CD 8
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IBM Rational Developer for System z and IBM Rational Application Developer
Installation CD 9

IBM Rational Developer for System z and IBM Rational Application Developer
Installation CD 10

IBM Rational Developer for System z and IBM Rational Application Developer
Installation CD 11

IBM Rational Developer for System z and IBM Rational Application Developer
Installation CD 12

IBM Rational Developer for System z and IBM Rational Application Developer
Installation CD 13

IBM Rational Developer for System z and IBM Rational Application Developer
Installation CD 14

IBM Rational Developer for System z and IBM Rational Application Developer
Installation CD 15

IBM Rational Developer for System z and IBM Rational Application Developer
Installation CD 16

IBM Rational Developer for System z and IBM Rational Application Developer
Product Activation Kit CD

+ IBM Rational Developer for System z electronic images

Once you have downloaded the Developer for System z images from Passport
Advantage® and expanded them, the following directories apply to installing

Developer for System z on the workstation:

DISK1
DISK2
DISK3
DISK4
DISK5
DISK6
DISK7
DISKS8
DISK9
DISK10
DISK11
DISK12
DISK13
DISK14
DISK15
DISK16
RDz-RAD-License

You must also have access to either of the following media to install required
System z server tools on the System z host:

 IBM Rational Developer for System z:

IBM Rational Developer for System z Server Tools CD

+ IBM Rational Developer for System z electronic image

Once you have downloaded the Developer for System z images from Passport
Advantage and expanded them, the following directory applies to installing

required software on the System z host:

IBM Rational Developer for System z Version 7.1 Installation Guide
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— Server Tools

See the IBM Rational Developer for System z Host Planning Guide (GI11-8296-00) ,
the Program Directory for IBM Rational Developer for System z (GI11-8298-00), and
the IBM Rational Developer for System z Host Configuration Guide (SC31-6930) for

details on installing required System z server tools.

In the remainder of this document, you can match references to CDs with
references to electronic image directories as shown in the following table:

Table 1.

CD Name Electronic
Image
Directory
Name

IBM Rational Developer for System z and IBM Rational Application Developer | DISK1

Installation CD 1

IBM Rational Developer for System z and IBM Rational Application Developer | DISK2

Installation CD 2

IBM Rational Developer for System z and IBM Rational Application Developer | DISK3

Installation CD 3

IBM Rational Developer for System z and IBM Rational Application Developer | DISK4

Installation CD 4

IBM Rational Developer for System z and IBM Rational Application Developer | DISK5

Installation CD 5

IBM Rational Developer for System z and IBM Rational Application Developer | DISK6

Installation CD 6

IBM Rational Developer for System z and IBM Rational Application Developer | DISK7

Installation CD 7

IBM Rational Developer for System z and IBM Rational Application Developer | DISK8

Installation CD 8

IBM Rational Developer for System z and IBM Rational Application Developer | DISK9

Installation CD 9

IBM Rational Developer for System z and IBM Rational Application Developer | DISK10

Installation CD 10

IBM Rational Developer for System z and IBM Rational Application Developer | DISK11

Installation CD 11

IBM Rational Developer for System z and IBM Rational Application Developer | DISK12

Installation CD 12

IBM Rational Developer for System z and IBM Rational Application Developer | DISK13

Installation CD 13

IBM Rational Developer for System z and IBM Rational Application Developer | DISK14

Installation CD 14

IBM Rational Developer for System z and IBM Rational Application Developer | DISK15

Installation CD 15

IBM Rational Developer for System z and IBM Rational Application Developer | DISK16

Installation CD 16

IBM Rational Developer for System z Server Tools CD ServerTools

IBM Rational Developer for System z and IBM Rational Application Developer | RDz-RAD-

Product Activation Kit CD License
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Meeting hardware and software requirements

The following information on hardware and software requirements for Developer
for System z, is also available in Prerequisites for IBM Rational Developer for System z.
A copy of this document is available in the root directory of IBM Rational Developer
for System z and IBM Rational Application Developer Installation CD 1.

Note: User authorization can affect your ability to perform the installation. You
must have administrator authority to install this product on your
workstation.

Client Prerequisites for IBM Rational Developer for System z
IBM Rational Developer for System z (Developer for System z) is a licensed
program to support users who wish to write large-scale business applications.

There are prerequisites and corequisites for using this software.
Hardware Requirements: Verify that you meet the minimum hard disk space

requirements to install the product. . The following table provides an account of
space requirements according to each aspect of the installation process.

Hardware Requirements

Processor 800 MHz Pentium(R) III or higher

Memory Minimum: 1 GB RAM

Disk space Minimum 2 GB of disk space is required to install the product.

Additional disk space is required for the resources that you develop.

* Disk space requirements can be reduced depending on the features
that you install.

* Additional disk space is required if you download the electronic
image to install the product.
* Additional disk space is required if you use FAT32 instead of NTFS.

* An additional 650 MB of disk space is required in the TEMP
directory.

Display 1024 x 768 display minimum using 256 Colors (Higher is recommended)

Other hardware | Microsoft® mouse or compatible pointing device

Software Requirements: Before you can install the product, verify that your
system meets the software requirements.

Operating Systems

The following operating systems are supported for this product:

Product Name PTF’s or Service Levels Required
Windows XP Professional Service Pack 2

Windows Server 2003 Enterprise Edition Service Pack 1

Windows Server 2003 Standard Edition Service Pack 1

Windows Vista Business No Service Level Required
Windows Vista Enterprise No Service Level Required
Windows Vista Ultimate No Service Level Required

IBM Rational Developer for System z Version 7.1 Installation Guide 5
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Additional Notes®:

1.

The above listed operating systems support all of the national languages that
are supported by Developer for System z.

Important: To enable users who do not have Administrator privileges to work
with Developer for System z and Rational Application Developer on a
Windows Vista system, do not install inside the Program Files directory
(C:\Program Files\).

Developer for System z was developed for use with an Eclipse IDE of version
3.2.2 or greater that uses at least version 1.5 of the IBM Java  Development Kit
(JDK). You may only extend an existing Eclipse IDE that meets these
requirements.

Developer for System z is compatible with Vista but does not take full
advantage of the new capabilities within Vista.

you must install using an Administrator id when installing Developer for
System z Microsoft Vista operating systems.

Additional Software Requirements: Developer for System z requires the
following to be installed as a prerequisite to installation.

Note: For information about supported database servers, Web application servers,

1.

and other software products, refer to the online help.
Rational Application Developer or IBM Rational Software Architect

Developer for System z requires either the IBM Rational Application Developer
7.0.0.3 offering or the IBM Rational Software Architect 7.0.0.3 offering to be
installed as a prerequisite to installation.

Program Product Name PTF’s or Service Levels Required
Number

5724-J19 IBM Rational Application Developer V. |No PTF or Service Level Required

7.0.0.3

5724-170 IBM Rational Software Architect V No PTF or Service Level Required

7.0.0.3

Additional Notes:

a. IBM Rational Application Developer 7.0.0.3 is included on the Rational
Developer for System z installation media, and the Installation Wizard will
guide you through the installation of IBM Rational Application Developer
7.0.0.3 and Rational Developer for System z 7.1 simultaneously.

b. If you already have IBM Rational Application Developer or Rational
Software Architect installed on your system, you will need to update your
existing installation to version 7.0.0.3 prior to installing Rational Developer
for System z 7.1. Additionally, the features listed below are required by
Rational Developer for System z and must be installed before Rational
Developer for System z can be installed. If any of the required features are
not installed, you will need to modify your existing installation to include
them before installing Rational Developer for System z.

* If you have IBM Rational Application Developer installed, the following
features are required:

— Web Development Tools
— J2EE and Web services development tools
— Test and Performance Tools Platform (TPTP)
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— J2EE Connector (J2C) tools

— Transformation authoring

— Plug-in Development Environment (PDE)

— Data tools

— WebSphere(R) Application Server development tools

— WebSphere(R) Application Server compile-time dependencies

 If you have Rational Software Architect installed, the following features
are required:

- UML Modeling

— UML-to-UML transformations and patterns

— J2EE and Web services development tools

— Web Development Tools

— J2EE Connector (J2C) tools

— Test and Performance Tools Platform (TPTP)

— Plug-in Development Environment (PDE)

— Data tools

— WebSphere® Application Server development tools

— WebSphere Application Server compile-time dependencies

Note:

If you are unsure of what is currently installed on your system,
Installation Manager provides an information page that will show
you what you have installed.

. The Installation Wizard will inform you of any modifications or updates
that need to be made to your existing installations and guide you through
the completion of the required tasks. Alternatively, you can always choose
to install IBM Rational Application Developer 7.0.0.3 again, along with
Rational Developer for System z, into a new package group without
affecting your existing installations.

. The related product website is:
http://www-306.1ibm.com/software/awdtools/developer/application/

2. TXSeries® for Multiplatforms v 6.1

One of the following levels must be installed to support applications with
embedded CICS® statements:

Program | Product Name PTF’s or Service Levels Required
Number
5655-M15 | TXSeries for Multiplatforms v 6.1 1700893

Additional Notes:
a. The related product website is:

http://www-306.1ibm.com/software/htp/cics/tserver/

3. DB2® Enterprise Server Edition for Windows

One of the following levels must be installed to support applications with
embedded CICS statements:

IBM Rational Developer for System z Version 7.1 Installation Guide
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Program | Product Name
Number

PTF’s or Service Levels Required

5765-F41 DB2 Enterprise Server Edition v 9.1 for

Windows

Additional Notes:
a. The related product website is:

http://www-306.1bm.com/software/data/db2/9/

4. Web Browser

One of the following web browsers must be installed to view the readme files

and the installation guide

Product Name

PTF’s or Service Levels Required

Microsoft Internet Explorer 6.0

Service Pack 1

Mozilla 1.6 or 1.7

all available maintenance

Firefox 1.0.x or 1.5

all available maintenance

5. Adobe Flash Player

The following must be installed on t properly view multimedia user assistance,
such as Tours, Tutorials, and Show me viewlets..

Product Name

PTF’s or Service Levels Required

Adobe Flash Player Version 6.0 165 or later

all available maintenance

6. Adobe Reader

The following must be installed on t properly view product documentation

PDFs..

Product Name

PTF’s or Service Levels Required

Adobe Reader Version 7.0 or later

all available maintenance

User privileges requirements: You must have a user ID that meets the following
requirements before you install IBM Rational Application Developer and IBM

Rational Developer for System z.

* Your user ID must not contain double-byte characters.

* For Windows Vista, you must log in to the Administrator account (or run as
Administrator; right-click the program file or shortcut and select Run as
Administrator) to perform the following tasks:

— Install or update IBM Installation Manager (the application that installs and

updates Developer for System z)

— Install or update a product offering.

— Install an Authorized-User license key for your product. You use IBM
Installation Manager to install license keys.

Note: To enable users who are not the Administrator to work with Developer
for System z on a Windows Vista system:

IBM Rational Developer for System z: Installation Guide




— Do not install Developer for System z into a package group
(installation location) in the Program Files directory (C:\Program
Files\) and do not choose a shared resources directory in the Program
Files directory.

— If you are extending an existing Eclipse installation, then do not install
Eclipse in the Program Files directory (C:\Program Files\).

* For other supported Windows versions, you must have a user ID that belongs to
the Administrators group.

Planning to install

Read all topics in this section before attempting to install any of the product
features. Many problems may be avoided by proper planning and understanding
the key aspects of the installation process before actually beginning installation.

Installation methods

There are a number of methods that you might use when installing Developer for
System z.

Some factors that might determine the installation method you use are:

* The format and method by which you access your installation files. (For
example, from CD or files downloaded from IBM Passport Advantage(R).)

* If you are installing onto your own workstation, or if you are making the
installation files available to your enterprise.

* If you will install using the Installation Manager GUI, or if you will install
silently.

The typical installation methods you might use are:

¢ Installing from the installation CD-ROMs.

¢ Installing from a downloaded electronic image on your workstation.
* Installing from an electronic image on a shared drive.

¢ Install from a repository on an HTTP server.

Note that with the latter three methods you could choose to run the Installation
Manager program in silent mode to install IBM Rational Application Developer
and Developer for System z. For details on running Installation Manager in silent
mode, see [“Installing silently” on page 45/

Installing from the CD-ROM

With this method, you have the CD-ROM disks containing the installation files,
and typically you are installing IBM Rational Application Developer and IBM
Rational Developer for System z on your own workstation. Refer to |“Insta11ing|
[BM Rational Developer for System z from a CD-ROM - task overview” on page 14|
for an overview of the steps.

Installing from a downloaded electronic image on your
workstation

With this method, you have downloaded the installation files from IBM Passport
Advantage and you will install IBM Rational Application Developer and IBM
Rational Developer for System z on your own workstation. Refer to |“Insta11in§|
[BM Rational Developer for System z from an electronic image on your|
workstation - task overview” on page 14| for an overview of the steps.

IBM Rational Developer for System z Version 7.1 Installation Guide 9
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Installing from an electronic image on a shared drive

With this method, you will place the electronic image on a shared drive so that
users in your enterprise can access the installation files for IBM Rational
Application Developer and IBM Rational Developer for System z from a single
location. Refer to[“Installing IBM Rational Developer for System z from an|
kelectronic image on a shared drive - task overview” on page 15 for an overview of
the steps.

Installing from a repository on an HTTP server

This method provides the fastest way to install across a network. This differs from
the previous method because, in order to place installation files for IBM Rational
Application Developer and IBM Rational Developer for System z on a HTTP Web
server, you must use a utility application - IBM Packaging Utility - provided with
IBM Rational Application Developer to copy the installation files in a package
format that can be used for installing IBM Rational Application Developer and IBM
Rational Developer for System z directly from a HTTP Web server. The directory
on the HTTP Web server containing the package is called a repository. The same
repository can also be used for other products, as well as future service updates.
Refer to|“Installing IBM Rational Developer for System z from a repository on a
HTTP Web server - task overview” on page 16|and[“Placing IBM Rationall
Developer for System z on an HTTP Web server - task overview” on page 17] for
an overview of the steps.

Deciding which features to install

With Version 7.1, you can customize your installation by selecting which features
of IBM Rational Developer for System z to install.

When you install the IBM Rational Developer for System z package using IBM
Installation Manager, the installation wizard displays the features in the package
and you can select which features to install. A recommended set of features is
selected by default (including any required features). Installation Manager
automatically enforces any dependencies between features and prevents you from
clearing any required features.

Note that once you finish installing the package, you can still add or remove
features from your installation by running the Modify Packages wizard in
Installation Manager. See[“Modifying installations” on page 57| for more
information.

Features

The following table shows the features of IBM Rational Developer for System z
that you can choose to install. Default selections of features to install may vary. If a
feature already exists in your shared resources directory and it is selected to be
installed, it will not be installed again. For information about the available features
of IBM Rational Application Developer, see the IBM Rational Application Developer
Installation Guide.
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Table 2.

Feature

Description

Selected for
installation by
default

System z Integrated
Development Environment
(required)

Provides an interactive,
workstation-based environment
where you can develop mainframe
applications in Assembler, COBOL,
PL/I, and C++, and
workstation-based applications in
COBOL and PL/L

Yes

Application Deployment
Manager

Provides a common deployment
approach and deployment application
programming interface for all IBM
Rational Developer for System z
components producing or generating
artifacts.

Yes

BMS Editor

Enables you to visually create and
modify Basic Mapping Support
(BMS) map sets. It is designed for
CICS developers who are familiar
with terminal-based tools (for
example, SDF II) or GUlI-based tools,
such as the BMS editor included with
VA COBOL.

Yes

MEFS Editor

Enables you to create and modify
Message Format Service (MFS)
message and format files. Many
Information Management System
(IMS(TM)) programs are based on
MFS, which is an IMS™ Transaction
Manager environment facility that
formats messages to and from
terminal devices.

Yes

Common Access Repository
Manager (CARMA)

Provides a unified interface and set
of services for accessing System
z-based source control management
tools. CARMA also provides a
generic graphical user interface (GUI)
client that can be used as a
framework for accessing and
interfacing with custom source
control management systems.

Yes

SCLM Developer Toolkit

Provides Software Configuration and
Library Manager (SCLM) access from
base Eclipse or from IBM Rational
Developer for System z.

Yes

IBM Rational Developer for System z Version 7.1 Installation Guide
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Table 2. (continued)

Feature

Description

Selected for
installation by
default

Enterprise Service Tools

Combines the functionality
previously offered in the Service
Flow Modeler (SFM) and XML
Services for the Enterprise (XSE).
Enterprise Service Tools (EST)
provide an integrated set of tools that
support modern application
architectures and the transformation
and reuse of existing application
processes. The tools support
generation of Web service
descriptions and service and flow
processing artifacts directly to a
z/OS(R) system. EST enables the
move towards service-oriented
architecture (SOA).

Yes

File Manager

Provides IBM File Manager for
2/0S® capabilities, including a
formatted edit session with multiple
views of the data of many dataset
types, to Rational Developer for
System z.

Note: This feature requires that you
have a license for IBM File Manager
for z/0OS.

Yes

Fault Analyzer

Enables you to work with fault
entries created by IBM Fault
Analyzer for z/OS during real-time
analysis of abending programs.

Note: This feature requires that you
have a license for IBM Fault Analyzer
for z/OS

Yes

Migrating WebSphere Developer for zSeries workspaces to
IBM Rational Developer for System z Version 7.1

If you have a workspace you used in WebSphere Developer for zSeries 6.0.1, and

you want to migrate the workspace for use with IBM Rational Developer for
System z 7.1, you must follow these steps.

1. Install IBM Rational Developer for System z 7.1.

2. Start IBM Rational Developer for System z, specifying the name of the

workspace you are migrating from WebSphere Developer for zSeries 6.0.1. The
old workspace is migrated so that all the old artifacts are present and appear in
the new workspace.

Migrating WebSphere Studio Enterprise Developer 5.1.1 and
5.1.2 workspaces to IBM Rational Developer for System z

Version 7.1

If you have a workspace you used in WebSphere Studio Enterprise Developer 5.1.1

or 5.1.2, and you want to migrate the workspace for use with IBM Rational
Developer for System z 7.1, you must follow these steps.
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Note: Be sure you still have WebSphere Studio Enterprise Developer 5.1.1 or 5.1.2

1.

installed on your workstation.

Get a copy of plugin com.ibm.ftt.ui.migration (in CD 1, directory
\WSED51xMigration), and add it to your existing WebSphere Studio Enterprise
Developer 5.1.1 or 5.1.2 system. Add the plugin by copying the
com.ibm.ftt.ui.migration directory to the install_directory\wstools\eclipse\
plugins directory on your machine.

Start WebSphere Studio Enterprise Developer 5.1.1 or 5.1.2.

Select Window -> Reset Perspective. You should see an action bar menu
Migration in the action bar.

Select Migration -> Prepare for Migration. A message appears and warns you
that this action will make your workspace unusable on WebSphere Studio
Enterprise Developer 5.1.1 or 5.1.2. You are asked if you want to continue.

Confirm that you want to continue. A message is displayed informing you that
a copy of the workspace has been saved and that the old workspace should
now be used on a IBM Rational Developer for System z system where the
migration will be completed.

Uninstall WebSphere Studio Enterprise Developer 5.1.1 or 5.1.2 and install IBM
Rational Developer for System z 7.1.

Start IBM Rational Developer for System z 7.1, specifying the name of the
workspace you are migrating from WebSphere Studio Enterprise Developer
5.1.1 or 5.1.2. The old workspace is migrated so that all the old artifacts are
present and appear in the new workspace.

Extracting and verifying electronic images

If you download the installation files from IBM Passport Advantage, you must
extract the electronic image from the compressed files before you can install IBM
Rational Application Developer and IBM Rational Developer for System z. You
may want to verify the completeness of the downloaded files before extracting the
image.

Preinstallation tasks

Before you install the product, complete the steps listed below.

1.

2.

Confirm that your system meets the requirements described in the section
Installation requirements.

Confirm that the directory pointed to by your environment variable TEMP (on
Windows systems) has at least 650 MB free. This is in addition to the space
required for installing the product.

Confirm that your user ID meets the required access privileges for installing the
product. See [“User privileges requirements” on page 8.

Read, the section Planning to install and give particular attention to the topic
Migration, upgrade and coexistence considerations.

Installation tasks

The following sections provide an overview of the installation scenarios described
in the section Installation scenarios. Detailed instructions, when necessary, are
linked to the main steps.
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Installing IBM Rational Developer for System z from a
CD-ROM - task overview

In this installation scenario, you have the CD-ROM disks containing the
installation files, and typically you are installing IBM Rational Application
Developer and IBM Rational Developer for System z on your own workstation.

The general steps for installing from a CD-ROM are:
1. Complete the pre-installation steps listed in Preinstallation tasks.

2. Insert the IBM Rational Developer for System z and IBM Rational Application
Developer Installation CD 1 into your CD-ROM drive.

3. If autorun is enabled on your system, the IBM Rational Developer for System z
launchpad program automatically opens. If autorun is not enabled, start the
launchpad program. Refer to [‘Installing from the launchpad program” on page|
for details.

4. Start the installation of IBM Rational Developer for System z from the
launchiad. For details, see [“Starting an installation from the launchpad” on|

5. Follow the on-screen instructions in the IBM Rational Developer for System z
Installation Wizard. The Installation Wizard guides you through any setup
tasks that may be required before the installation. When applicable, Installation
Manager is launched to allow you to complete the required tasks. The actual
installation of Developer for System z is performed by Installation Manager.
See [‘Using the IBM Rational Developer for System z InstallationWizard” on|
[page 22| for more information.

If Installation Manager is not detected on your workstation, you are prompted
to install it. Follow the on-screen instructions in the Installation Manager
wizard to complete the installation of Installation Manager. See [“Installing

[Installation Manager” on page 17|for details.

When the installation of Installation Manager completes, or if it is already on
your system, Installation Manager starts and automatically begins the Install
Packages wizard.

6. Follow the on-screen instructions in the Install Packages wizard to complete the
installation. The steps to complete the installation may vary depending on your
installation scenario. For complete details, see [‘Determining the correct|
[installation steps for your scenario” on page 23

7. Initially, trial licenses for IBM Rational Application Developer and IBM Rational
Developer for System z are installed. You must import the IBM Rational
Application Developer product activation kit and the IBM Rational Developer
for System z activation kit to upgrade your trial licenses to a permanent
licenses and ensure you have continued access to work with the product. Refer
to[“Managing licenses” on page 53 for details. If you have an existing IBM
Rational Application Developer or Rational Software Architect installation and
have already installed a permanent license, you do not need to install it again
for that product.

8. Install additional software included with IBM Rational Developer for System z.
For more information, see [“Installing additional software” on page 59)

Installing IBM Rational Developer for System z from an
electronic image on your workstation - task overview

The general steps for installing IBM Rational Application Developer and IBM
Rational Developer for System z from an electronic installation image.
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1. Ensure that your workstation has sufficient space to store both the files you
must download from IBM Passport Advantage and the extracted installation
image. Refer to [“Hardware Requirements” on page 5]

2. Download all required parts for the product image from IBM Passport
Advantage to a temporary directory.

3. Extract the installation image from the downloaded files and verify the
installation image is complete. See |”Extracting and verifying electronic images”|

for details.

4. Continue with the steps in "Installing from an electronic image" below.

Installing from an electronic image
1. Complete the pre-installation steps listed in Preinstallation tasks.

2. Start the launchpad program. Refer to [“Installing from the launchpad program”|

for details.

3. Start the installation of IBM Rational Developer for System z from the
launchi ad. For details, see [“Starting an installation from the launchpad” on|

4. 4. Follow the on-screen instructions in the IBM Rational Developer for System z
Installation Wizard. The Installation Wizard guides you through any setup
tasks that may be required before the installation. When applicable, IBM
Installation Manager is launched to allow you to complete the required tasks.
The actual installation of Developer for System z is performed by IBM
Installation Manager. See|“Using the IBM Rational Developer for System Z|
[InstallationWizard” on page 22| for more information.

If IBM Installation manager is not detected on your workstation, you are
prompted to install it. Follow the on-screen instructions in the Installation
Manager wizard to complete the installation of Installation Manager. See
[“Installing Installation Manager” on page 17| for details.

When the installation of Installation Manager completes, or if it is already on
your system, Installation Manager starts and automatically begins the Install
Packages wizard.

5. Follow the on-screen instructions in the Install Packages wizard to complete the
installation. The steps to complete the installation may vary depending on your
installation scenario. For complete details, see [‘Determining the correct]
[installation steps for your scenario” on page 23.|

6. Configure your product licenses. Initially, trial licenses for IBM Rational
Application Developer and IBM Rational Developer for System z are installed.
You must import the IBM Rational Application Developer product activation kit
and the IBM Rational Developer for System z activation kit to upgrade your
trial licenses to a permanent licenses and ensure you have continued access to
work with the product. Refer to|“Managing licenses” on page 55 for details. If
you have an existing IBM Rational Application Developer or Rational Software
Architect installation and have already installed a permanent license, you do
not need to install it again for that product.

7. Install additional software included with IBM Rational Developer for System z.
For more information, see [“Installing additional software” on page 59)

Installing IBM Rational Developer for System z from an
electronic image on a shared drive - task overview

In this scenario, you will place the electronic image on a shared drive so that users
in your enterprise can access the installation files for IBM Rational Application
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Developer and IBM Rational Developer for System z from a single location. The
following steps are performed by the person placing the installation image on a
shared drive.

1. Ensure that your shared drive has sufficient disk space to store both the files
you must download from IBM Passport Advantage and the extracted
installation image. Refer to [“Hardware Requirements” on page 5| for details.

2. Download all required parts for the product image from IBM Passport
Advantage to a temporary directory on the shared drive. Note that you could
choose instead download the parts to your workstation and copy only the
extracted installation image to the shared drive.

3. Extract the installation image from the downloaded files into an accessible
directory on the shared drive and verify the installation image is complete. See
[“Extracting and verifying electronic images” on page 13|for details

To install IBM Rational Application Developer and IBM Rational Developer for
System z from the installation files on the shared drive:

1. Change to the diskl directory on the shared drive containing the installation
image.

2. Follow the steps in [“Installing from an electronic image” on page 15/

Installing IBM Rational Developer for System z from a
repository on a HTTP Web server - task overview

In this scenario, the product packages are retrieved by the IBM Installation
Manager from an HTTP Web server.

These steps assume the repository containing the packages for IBM Rational
Application Developer and IBM Rational Developer for System z has been created
on the HTTP Web server. Refer to [“Placing IBM Rational Developer for System z|
fon an HTTP Web server - task overview” on page 17] for details on copying the
installation packages to an HTTP Web server.

To install the IBM Rational Application Developer and IBM Rational Developer for
System z packages from a repository on an HTTP server:

1. Complete the pre-installation steps listed in Preinstallation tasks.

2. Install IBM Installation Manager. Refer to [“Installing Installation Manager” on|

3. Start Installation Manager. Refer to [“Starting Installation Manager” on page 1§
for details.

4. Set the URL of the repository containing the packages of IBM Rational
Application Developer and IBM Rational Developer for System z packages as a
repository preference in Installation Manager. See |“Setting repository|
[preferences in Installation Manager” on page 18|

5. Click Install Packages to start the Install Packages wizard in Installation
Manager, and follow the on-screen instructions in the Install Packages wizard
to complete the installation. The steps to complete the installation may var
depending on your installation scenario. For complete details, seel”Determiningl
[the correct installation steps for your scenario” on page 23/

6. Configure your product licenses. Initially, trial licenses for IBM Rational
Application Developer and IBM Rational Developer for System z are installed.
You must import the IBM Rational Application Developer product activation kit
and the IBM Rational Developer for System z activation kit to upgrade your
trial licenses to a permanent licenses and ensure you have continued access to
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work with the product. Refer to[“Managing licenses” on page 55 If you have an
existing IBM Rational Application Developer or Rational Software Architect
installation and have already installed a permanent license, you do not need to
install it again for that product.

7. Install additional software included with IBM Rational Developer for System z.
For more information, see [“Installing additional software” on page 59/

Placing IBM Rational Developer for System z on an HTTP Web
server - task overview

You can place the IBM Rational Application Developer and IBM Rational
Developer for System z install packages on an HTTP Web server by using the IBM
Packaging Utility to create an installation repository or copy to an existing
repository. Refer to|“Copying packages to a HTTP server using the Packaging]
[Utility” on page 54/ for details on using the Packaging Utility to create an
installation repository. Once you have created your repository, you can:

1. Provide users in your enterprise with the URL of the installation package
repository.

2. Use the repository to perform silent installations. Refer to [“Installing silently”|
for details on running silent installations.

Managing Installation Manager

Installing Installation Manager

IBM Installation Manager is typically started by the Developer for System z
Installation Wizard. For more information on this process, refer to [“Installing from|
fthe launchpad program” on page 20.|

You can install IBM Installation Manager by running the install_win32.exe program
located at the root of CD1. To install the Installation Manager manually:

1. Review the license agreement on the License Agreement page and select I
accept the terms in the license agreement to accept. Click Next.

2. Click the Change button on the Destination Folder page to change the install
location if desired. Click Next.

3. Click Next on the Setup Type page.

4. Click Install on the Ready to Install Program page. The Completed page
appears after the installation is complete.

5. Click Finish.

You can also perform a silent installation of the Installation Manager using the

following steps:

1. Insert the IBM Rational Developer for System z and IBM Rational Application
Developer Installation CD 1.

2. If you want to make the Installation Manager installer available to other users
on your network, copy the contents of the InstallerImage_win32 folder from
the CD to a shared location on your network.

3. Run the following command, either from the IBM Rational Developer for
System z CD1 or from the shared network location to which you copied the
installation files.

Substitute your desired installation location for the value of the INSTALLDIR
parameter:
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Setup.exe /S /v"/gn INSTALLDIR=\"C:\Program
Files\IBM\Installation Manager\""

Starting Installation Manager

The IBM Installation Manager should be started automatically by the Developer for
System z Installation Wizard. This starts the Installation Manager with the correct
repository preferences for installing the IBM Rational Application Developer and
IBM Rational Developer for System z packages. If you start the Installation
Manager directly, then you must set repository preference and choose product
packages manually. To start the Installation Manager manually:

1. Open the Start menu from the Taskbar.

2. Select All Programs -> IBM Installation Manager -> IBM Installation
Manager.

Uninstalling Installation Manager

The IBM Installation Manager must be uninstalled using the Add or Remove
Programs program.

1. Open the Start menu from the Taskbar.

2. Select Control Panel -> Add or Remove Programs -> IBM Installation
Manager.

3. Click the Remove button and follow the instructions provided by the operating
system.

Note: You cannot uninstall IBM Installation Manager until all packages have been
uninstalled.

Installation repositories

Installation Manager retrieves product packages from specified repository
locations.

If Installation Manager is started by the LaunchPad or the Installation Wizard, the
repository information is passed to Installation Manager. If the Installation
Manager is started by itself, you must specify an installation repository that
contains the product packages that you want to install.

Some organizations may bundle and host their own product packages within their
intranet. For this type of business case scenario, see [“Installing from a repositoryj
fon an HTTP server” on page 10] Your system administrators will need to provide
you with the correct URL.

By default, IBM Installation Manager uses an embedded URL in each software
development product to connect to a repository server through the Internet and
search for installable packages as well as new features.

Setting repository preferences in Installation Manager

When you start the installation of IBM Rational Application Developer and IBM
Rational Developer for System z from the launchpad program or Installation
Wizard, the location of the repository containing the package you are installing is
automatically defined in Installation Manager when it starts. However, if you start
Installation Manager directly, for example to install IBM Rational Developer for
System z and IBM Rational Application Developer from a repository located on a
Web server, then you must set the repository preference (the URL for the directory
containing the package) in Installation Manager before you can install the package
This is done on the Repositories page of the Preferences window. By default, IBM
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Installation Manager uses an embedded URL in each Rational software
development product to connect to a repository server through the Internet and
search for installable packages, updates and new features. Your organization may
require you to redirect the repository to use intranet sites.

Note: Before starting the installation process, be sure to obtain the installation
package repository URL from your administrator.

To add, edit, or remove a repository location in Installation Manager:
1. Start Installation Manager.

2. On the Start page of Installation Manager, click File -> Preferences, and then
click Repositories. The Repositories page opens, showing any available
repositories, their locations, and whether or not they are accessible.

3. On the Repositories page, click Add Repository.

4. On the Add repository window, enter the URL of the repository location or
browse to it and enter a file path, and then click OK. The new or changed
repository location is listed. If the repository is not accessible, a red x is
displayed in the Accessible column.

5. Click OK to exit.

Package groups and the shared resource directory

When you install the IBM Rational Application Developer and IBM Rational
Developer for System z packages with IBM Installation Manager, you must choose
a package group and a shared resource directory.

Package groups

During the installation process, you must specify a package group for the IBM
Rational Application Developer and IBM Rational Developer for System z
packages. A package group represents a directory in which packages share
resources with other packages in the same group. When you install the IBM
Rational Application Developer and IBM Rational Developer for System z packages
with Installation Manager, you can choose to create a new package group or install
the packages into an existing package group. (Some packages might not be able to
share a package group, in which case the option to use an existing package group
will be disabled.)

Note that when you install multiple packages at the same time, all the packages
are installed into the same package group.

A package group is assigned a name automatically; however, you choose the
installation directory for the package group.

Important: To enable users who do not have Administrator privileges to work with
Developer for System z in the Windows Vista operating system, do not choose an
installation directory inside the Program Files directory (C:\Program Files\).

Once you create the package group by successfully installing a package, you
cannot change the installation directory. The installation directory contains files
and resources specific to the packages installed into that package group. Resources
in the packages that can potentially be used by other package groups are placed in
the shared resources directory.

Shared resources directory

IBM Rational Developer for System z Version 7.1 Installation Guide 19



The shared resources directory is the directory where installation artifacts are
located that can be used by one or more package groups.

Important: You can specify the shared resources directory once: the first time that
you install a package. For best results, use your largest drive for this. You cannot
change the directory location unless you uninstall all packages.

Important: To enable users who do not have Administrator privileges to work with
Rational Developer for System z on a Windows Vista system, do not choose a
directory inside the Program Files directory (C:\Program Files\).

Extending an existing Eclipse IDE

When you install the IBM Rational Application Developer and IBM Rational
Developer for System z packages, you may choose to extend an Eclipse integrated
development environment (IDE) already installed on your system by adding the
functionality contained in the IBM Rational Application Developer and IBM
Rational Developer for System z packages.

The IBM Rational Application Developer package that you install with IBM
Installation Manager is bundled with a version of the Eclipse IDE or workbench.
This bundled workbench is the base platform for providing the functionality in the
Installation Manager package. However, if you have an existing Eclipse IDE on
your workstation, then you have the option to extend - add to the IDE the
additional functionality provided in the Installation Manager package - that Eclipse
instance.

Select the Extend an existing Eclipse IDE option on the Location page of the
Install Packages wizard to extend an existing Eclipse IDE.

Important: To enable users who do not have Administrator privileges to work with
Rational Developer for System z in the Windows Vista operating system, do not
install Eclipse inside the Program Files directory (C:\Program Files\)

You might extend your existing Eclipse IDE, for example, because you want to
gain the functionality provided in the Installation Manager package, but you also
want to have the preferences and settings in your current IDE when you work
with the functionality from the Installation Manager package. You also might want
to work with plug-ins you have installed that already extend the Eclipse IDE.

Your existing Eclipse IDE must be version 3.2.2 and must use at least version 1.5 of
the IBM Java Development Kit (JDK) to be extended. Installation Manager checks
that the Eclipse instance you specify meets the requirements for the installation
package.

Installing from

the launchpad program

The launchpad program provides you with a single location to view release
information and start the installation process.

Use the launchpad program to start the installation of IBM Rational Application
Developer and IBM Rational Developer for System z in the following cases:

* You are installing from the product CDs.
* You are installing from an electronic image on your workstation.
* You are installing from an electronic image on a shared drive.
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By starting the installation process from the launchpad program, the IBM Rational
Developer for System z Installation Wizard starts IBM Installation Manager
preconfigured with the location of the repository containing the IBM Rational
Application Developer andIBM Rational Developer for System z packages. If you
install and start Installation Manager directly, then you must set the repository
preference manually.

To install from the launchpad:

1. Complete the preinstallation tasks described in Preinstallation tasks, if you have
not done so already.

2. Start the launchpad program. See[“Starting an installation from the launchpad.”]

3. Start the Developer for System z Installation Wizard by clicking on the Install
IBM Rational Developer for System z link. See [“Using the IBM Rationall
[Developer for System z InstallationWizard” on page 22|for more information.

4. Follow the instructions on the Installation Wizard panels

5. When you are ready to begin the installation, the Installation Wizard
automatically launches IBM Installation Manager. Follow the on-screen
instructions on the Installation Manager panels to complete the installation. The
steps to complete the installation may vary depending on your installation
scenario. For complete details, see [“Determining the correct installation steps|
[for your scenario” on page 23

Follow the on-screen instructions in the Install Packages wizard to complete the
installation.

Starting an installation from the launchpad

Complete the preinstallation tasks described in Preinstallation tasks, if you have
not done so already.

If you are installing from a CD and autorun is enabled on your workstation, then
the IBM Rational Developer for System z launchpad starts automatically when you
insert the first installation disk into your CD drive. If you are installing from an
electronic image, or if auto-run is not configured on your workstation, then you
must start the launchpad program manually. To start the launchpad:

1. Insert the IBM Rational Developer for System z and IBM Rational Application
Developer Installation CD 1 into your CD drive.

2. If auto-run is enabled on your system, the IBM Rational Application Developer
and IBM Rational Developer for System z launchpad program automatically
opens. If auto-run is not enabled on your system:

* Run RDzInstallLaunchpad.exe located in the root directory of the CD.

3. If you have not done so already, read the release information by clicking
Release notes.

4. When you are ready to begin the installation, click Install IBM Rational
Developer for System z.

5. The Developer for System z Installation Wizard starts. Follow the instructions
on the Installation Wizard panels to complete any setup tasks that are required
before you proceed with the installation. See |“Using the IBM Rational|
[Developer for System z InstallationWizard” on page 22[for more information.

6. When you are ready to begin the installation, the Installation Wizard launches
Installation Manager. Follow the on-screen instructions in the Install Packages
wizard to complete the installation. The steps to complete the installation may
vary depending on your installation scenario. For complete details, see
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[“Determining the correct installation steps for your scenario” on page 23|If
IBM Installation Manager is not detected on your system, you will be prompted
to install it. See [“Installing Installation Manager” on page 17| for more
information.

7. Configure your product licenses. Initially, trial licenses for IBM Rational
Application Developer and IBM Rational Developer for System z are installed.
You must import the IBM Rational Application Developer product activation kit
and the IBM Rational Developer for System z activation kit to upgrade your
trial licenses to a permanent licenses and ensure you have continued access to
work with the product. Refer to[“Managing licenses” on page 55 for details. If
you have an existing IBM Rational Application Developer or Rational Software
Architect installation and have already installed a permanent license, you do
not need to install it again for that product.

Using the IBM Rational Developer for System z InstallationWizard

22

When you start the Developer for System z installation from the launchpad, you
are presented with the Developer for System z Installation Wizard. The Installation
Wizard guides you through the installation setup process and ensures that your
machine is properly configured to install IBM Rational Developer for System z.
Depending on your current system configuration and installation history, the setup
process may involve modifying or updating an existing installation of Rational
Application Developer, Rational Software Architect, or WebSphere Developer for
System z before you are ready to install IBM Rational Developer for System z v
7.1.

The installation itself, as well as any required modification and update tasks, are
performed by IBM Installation Manager. The Installation Wizard analyzes your
system and informs you of any setup tasks that must be performed prior to the
Developer for System z installation. When applicable, the Installation Wizard
launches IBM Installation Manager to allow you to perform the required setup
tasks. At any point, you can click Help on the Installation Wizard panels to view
the appropriate section of this Installation Guide for further assistance. When you
are ready to begin the Developer for System z installation, the Installation Wizard
launches IBM Installation Manager.

To use the Rational Developer for System z Installation Wizard:

1. Start the Developer for System z Installation Wizard from the launchpad b
clicking on the Install IBM Rational Developer for System z link. See ”Startina
[an installation from the launchpad” on page 21|for more information.

2. Follow the instructions on the Installation Wizard panels to complete any
required setup tasks. When applicable, the Installation Wizard launches IBM
Installation Manager for you automatically. If at any point you need to start
Installation Manager and it is not started for you automatically by the
Installation Wizard, you can do so by running the startRDzInstall.bat file
located in the root directory of CD1.

3. When you are ready to begin the installation of Developer for System z, the
Installation Wizard launches IBM Installation Manager for you automatically so
you can proceed with the installation. The steps to complete the installation
may vary depending on your installation scenario. See I”Determining the correctl
[installation steps for your scenario” on page 23 for more information.
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Determining what is currently installed on your system

You may need to determine what package groups, packages, and features are
currently installed on your system to determine if you need to modify or update
an existing installation before installing Developer for System z. Installation
Manager provides a convenient information page that shows you what package
groups and packages are currently installed on your system, as well as which
features you have installed for each package. You can view this information two
ways:

1. From the Windows Start menu, click Start -> All Programs -> IBM Installation
Manager -> View Installed Packages. This will launch your internet browser
and display the Installation Manager installed packages page in the browser
window.

2. From within Installation Manager, click File > View Installed Packages. This
will bring up a new window with the installed packages information. To start
Installation Manager, from the Windows Start menu click Start -> All Programs
-> IBM Installation Manager -> IBM Installation Manager.

Determining the correct installation steps for your scenario

If you have any existing installations of IBM Rational Application Developer 7.0,
Rational Software Architect 7.0, or WebSphere Developer for System z Version 7.0
on your system, you may need to modify or update your existing installations
before installing IBM Rational Developer for System z Version 7.1.

Developer for System z requires IBM Rational Application Developer version
7.0.0.3 or Rational Software Architect version 7.0.0.3. Additionally, several features
of IBM Rational Application Developer or Rational Software Architect are required.
If any of the required features were not installed when you initially installed IBM
Rational Application Developer or Rational Software Architect, you will be
required to modify your existing installation to include these features prior to
installing Developer for System z.

If you have an existing installation of WebSphere Developer for System z, IBM
Rational Developer for System z Version 7.1 can also be installed as an update to
your existing installation rather than as a full product installation.

IBM Rational Developer for System z Version 7.1 includes an Installation Wizard to
guide you through the necessary steps to install Developer for System z. You can
start the Installation Wizard from the Developer for System z lauchpad. See
[‘Starting an installation from the launchpad” on page 21| for details on how to
start the Installation Wizard from the launchpad.

The Developer for System z Installation Wizard automatically launches the IBM
Installation Manager which performs the actual installation of Developer for
System z. If you do not already have IBM Installation Manager installed on your
system from a previous product installation, the Developer for System z
Installation Wizard launches the IBM Installation Manager installation for you.

Refer to the following sections to determine your installation scenario and the
steps required to install Developer for System z. As you go through the installation
wizard, you may be prompted to modify or update your existing installations
before the Developer for System z installation can proceed. The Help button on the
Installation Wizard panels launches your internet browser and takes you to the
appropriate section of this document to assist you in completing the required task.
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Installing onto a clean system

24

For the purposes of installing Developer for System z, a system with no prior
installations of IBM Rational Application Developer 7.0, Rational Software Architect
7.0, or WebSphere Developer for System z v 7.0 is referred to as a clean system.

Installing Developer for System z onto a clean system is the most basic installation
scenario. If you do not already have IBM Installation Manager installed, the
Installation Wizard launches the IBM Installation Manager installation for you.
Once Installation Manager is installed, it is automatically launched to allow you to
proceed with the installation of Developer for System z.

Note: If the Installation Wizard does not automatically start the Installation
Manager for you, you can start Installation Manager by running the
startRDzInstall.bat file located in the root directory of CD1.

When Installation Manager is launched, the Install Packages panel appears with
the IBM Rational Application Developer 7.0.0.3 and Developer for System z
offerings selected for installation.

The following steps will guide you through the installation of IBM Rational
Application Developer 7.0.0.3 and Developer for System z using Installation
Manager on a clean system:

1. On the Install Packages panel, select the IBM Rational Application Developer
7.0.0.3 and Developer for System z offerings. You can click on the name of each
offering to view more information about it. Information is displayed in the
Details section at the bottom of the panel.

When you are ready to continue the installation, click Next. Installation
Manager gathers information about the packages you have selected and
proceeds to the Licenses panel.

2. On the Licenses panel, read the license agreement for the selected packages.
There is a license agreement for each package you select to install. On the left
side of the License panel, click each package name to display the corresponding
license agreement. You may be prompted to update IBM Installation Manager
to a newer version if one is available. If prompted, click Yes to install the
update. Installation Manager updates itself and informs you that it must restart
to complete the update. Click OK to restart Installation Manager.

a. If you agree to the terms of all of the license agreements, click I accept the
terms of the license agreements.

b. Click Next to continue.

3. On the Location panel, type the path for the shared resources directory in the
Shared Resources Directory field. The shared resources directory contains
resources that are shared by one or more package groups, and is where a large
portion of the files for all offerings are installed.

Important: You can only specify the shared resources directory the first time
that you install a package. Use your largest drive for this to ensure adequate
space for the shared resources of future packages.

Important: To enable users who do not have Administrator privileges to work
with Developer for System z in the Windows Vista operating system, do not
choose a Shared Resources directory inside the Program Files directory
(C:\Program Files\).
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Note: To change this directory location you must uninstall all packages and
re-install the packages, specifying a new shared resources directory.
Click Next to continue.

4. On the next Location panel you create a new package group to contain your
IBM Rational Application Developer and Developer for System z packages. A
package group represents a location into which many offerings can be installed
and share resources with each other. Any offerings you install into a package
group will share resources with all other offerings in that package group See
[“Package groups and the shared resource directory” on page 19| for more
information.

You can create multiple package groups on your system. Each package group
you create remains separate from all other package groups on the system. To
create a new package group:

a. Click the Create a new package group radio button.

b. Enter the path for the installation directory you wish to use for the package
group. The installation directory is only used for this package group. The
installation directory must be a new or empty directory on your system.

Important: To enable users who do not have Administrator privileges to
work with Developer for System z in the Windows Vista operating system,
do not choose a Shared Resources directory inside the Program Files
directory (C:\Program Files\).

c. The name for the package group is created automatically.
d. Click Next to continue.

5. On the next Location panel, you can choose to extend an existing Eclipse IDE
already installed on your system, adding the functionality in the packages that
you are installing. You must have Eclipse Version 3.2.2 using IBM Java
Development Kit (JDK) version 1.5 or higher to select this option. It is
recommended that you use the Eclipse and JDK packaged with the product
instead of extending an existing one.

 If you do not want to extend an existing Eclipse IDE, click Next to continue.
* To extend an existing Eclipse IDE:
a. Select Extend an existing Eclipse.

b. In the Eclipse IDE field, type or navigate to the location of the folder
containing the eclipse executable file (eclipse.exe). Installation Manager
checks if the Eclipse IDE version is valid for the package that you are
installing. The Eclipse IDE JVM field displays the Java Virtual Machine
(JVM) for the IDE that you specified.

c. Click Next to continue.

6. On the next Location page under Languages, select the languages you wish to
install for this package group. The corresponding national language translations
for the user interface and documentation for the IBM Rational Application
Developer and Developer for System z packages will be installed.

Note: Your choices apply to all packages installed in this package group.

7. On the Features panel, select the features that you want to install for each
offering. You can click on the name of any feature to view a description of that
feature. The feature description is displayed in the Details section at the bottom
of the panel.

Note: Developer for System z requires several features of IBM Rational

Application Developer in order to install. All of the required features are
selected by default on the panel. If any of the required features are not
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selected, you will see an error message displayed at the top of the panel
indicating the names of the features that need to be installed. You may
add any additional optional features that you would like to install,
however it is recommended that you do not remove any of the
preselected features from the list.

The following is a list of the features of IBM Rational Application Developer
that are required by Developer for System z and must be installed:

¢ Web Development Tools

* J2EE and Web services development tools

* Test and Performance Tools Platform (TPTP)

* J2EE Connector (J2C) tools

* Transformation authoring

¢ Plug-in Development Environment (PDE)

* Data tools

* WebSphere Application Server development tools

* WebSphere Application Server compile-time dependencies

When you have finished selecting the features you want to install, click Next.

8. On the Summary panel, review your choices before you begin installing IBM
Rational Application Developer 7.0.0.3 and Developer for System z v 7.1. If you
want to change the choices you made on previous panels, click Back and make
your changes. When you are satisfied with your installation choices, click
Install to install the packages. The installation begins and a progress indicator
shows you the percentage of the installation complete.

9. When the installation process is complete, a message confirms the success of
the installation.

a. To view the installation log file for the current session, click View log file to
open the installation log in a new window.

b. Important: The final installation panel provides you with the option of
launching IBM Rational Application Developer when you click Finish and
exit the installation. Doing so results in an error message from Developer
for System z about a missing TPFSHARE environment variable. Do not select
the Launch IBM Rational Application Developer button on the right side
of the panel. Instead, click None and then click Finish. Installation Manager
will close and you can then launch Developer for System z from the
Windows Start menu. Select Start -> All Programs -> [package group
name] -> IBM Rational Developer for System z -> IBM Rational
Developer for System z.

Installing into a new package group

26

Regardless of any existing installations you may have on your system, you always
have the option of performing a clean installation of IBM Rational Application
Developer and Developer for System z into a new package group as an alternative
to modifying and updating installations in an existing package group.

Installing into a new package group allows you to perform additional installations
of IBM Rational Application Developer and Developer for System z that remain
separate from any existing installations in other package groups. Files that have
already been installed into the Shared Resources directory during previous
installations of IBM Rational Application Developer and Developer for System z
will not need to be reinstalled, so the installation into a new package group may
require less time and space than the previous installation.
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If the Developer for System z Installation Wizard detects a previous installation of
Rational Application Developer, Rational Software Architect or WebSphere
Developer for System z v 7.0, it gives you the option of installing IBM Rational
Application Developer and IBM Rational Developer for System z into a new
package group instead of modifying and updating an existing package group.

Note: If the Installation Wizard does not automatically start the Installation
Manager for you, you can start Installation Manager by running the
startRDzInstall.bat file located in the root directory of CD1.

The following steps will guide you through the installation of IBM Rational
Application Developer and Developer for System z into a new package group
using Installation Manager:

1. On the Install Packages panel, select the IBM Rational Application Developer
7.0.0.3 and Developer for System z offerings. You can click on the name of each
offering to view more information about it. Information is displayed in the
Details section at the bottom of the panel. You may be prompted to update IBM
Installation Manager to a newer version if one is available. If prompted, click
Yes to install the update. Installation Manager updates itself and informs you
that it must restart to complete the update. Click OK to restart Installation
Manager.

When you are ready to continue the installation, click Next. Installation
Manager will gather information about the packages you have selected and
proceed to the Licenses panel.

2. On the Licenses panel, read the license agreements for the selected packages.
There is a license agreement for each package you selected to install. On the left
side of the License panel, click each package name to display the corresponding
license agreement.

a. If you agree to the terms of all of the license agreements, click I accept the
terms of the license agreements.

b. Click Next to continue.

3. On the Location panel, type the path for the shared resources directory in the
Shared Resources Directory field. The shared resources directory contains
resources that are shared by one or more package groups, and is where a large
portion of the files for all offerings are installed.

Important: You can only specify the shared resources directory the first time
that you install a package. Use your largest drive for this to ensure adequate
space for the shared resources of future packages.

Important: To enable users who do not have Administrator privileges to work
with Developer for System z in the Windows Vista operating system, do not
choose a Shared Resources directory inside the Program Files directory
(C:\Program Files\).

Note: To change this directory location you must uninstall all packages and
re-install the packages, specifying a new shared resources directory.
Click Next to continue.

4. On the next Location panel you create a new package group to contain your
IBM Rational Application Developer and Developer for System z packages. A
package group represents a location into which many offerings can be installed
and share resources with each other. Any offerings you install into a package
group will share resources with all other offerings in that package group. See
[“Package groups and the shared resource directory” on page 19| for more
information.
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You can create multiple package groups on your system. Each package group
you create will remain separate from all other package groups on the system.
To create a new package group:

a. Click the Create a new package group radio button.

b. Enter the path for the installation directory you wish to use for the package
group. The installation directory must be a new or empty directory on your
system.

c. The name for the package group is created automatically.
d. Click Next to continue.

. On the next Location panel, you can choose to extend an existing Eclipse IDE

already installed on your system, adding the functionality in the packages that
you are installing. You must have Eclipse Version 3.2.2 using IBM Java
Development Kit (JDK) version 1.5 or higher to select this option. It is
recommended that you use the Eclipse and JDK packaged with the product
instead of extending an existing one.

* If you do not want to extend an existing Eclipse IDE, click Next to continue.
* To extend an existing Eclipse IDE:
a. Select Extend an existing Eclipse.

b. In the Eclipse IDE field, type or navigate to the location of the folder
containing the eclipse executable file (eclipse.exe). Installation Manager
checks if the Eclipse IDE version is valid for the package that you are
installing. The Eclipse IDE JVM field displays the Java Virtual Machine
(JVM) for the IDE that you specified.

c. Click Next to continue.

. On the next Location page under Languages, select the languages you wish to

install for this package group. TThe corresponding national language
translations for the user interface and documentation for the IBM Rational
Application Developer and Developer for System z packages will be installed.

Note: Your choices apply to all packages installed in this package group.

. On the Features panel, select the features that you want to install for each

offering. You can click on the name of any feature to view a description of that
feature. The feature description is displayed in the Details section at the bottom
of the panel.

Note: Developer for System z requires several features of IBM Rational
Application Developer in order to install. All of the required features are
selected by default on the panel.. If any of the required features are not
selected, you will see an error message displayed at the top of the panel
indicating the names of the features that need to be installed. You may
add any additional optional features that you would like to install,
however it is recommended that you do not remove any of the
preselected features of IBM Rational Application Developer.

The following IBM Rational Application Developer features are required by

Developer for System z and must be installed:

¢ Web Development Tools

* J2EE and Web services development tools

* Test and Performance Tools Platform (TPTP)
* J2EE Connector (J2C) tools

* Transformation authoring

¢ Plug-in Development Environment (PDE)
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* Data tools
* WebSphere Application Server development tools
* WebSphere Application Server compile-time dependencies

When you have finished selecting the features you want to install, click Next.

On the Summary panel, review your choices before you begin installing IBM
Rational Application Developer 7.0.0.3 and Developer for System z v 7.1. If you
want to change the choices you made on previous panels, click Back and make
your changes. When you are satisfied with your installation choices, click
Install to install the packages. The installation begins and a progress indicator
shows you the percentage of the installation completed.

When the installation process is complete, a message confirms the success of
the installation.

a. To view the installation log file for the current session, click View log file to
open the installation log in a new window.

b. Important: The final installation panel provides you with the option of
launching IBM Rational Application Developer when you click Finish and
exit the installation. Doing so results in an error message from Developer
for System z about a missing TPFSHARE environment variable. Do not select
the Launch IBM Rational Application Developer button on the right side
of the panel. Instead, click None and then click Finish. Installation Manager
will close and you can then launch Developer for System z from the
Windows Start menu. Select Start -> All Programs -> [package group
name] -> IBM Rational Developer for System z -> IBM Rational
Developer for System z.

Updating an existing installation of IBM Rational Application Developer
and WebSphere Developer for System z

You can install Developer for System z as an update to an existing WebSphere
Developer for System z 7.0.x installation. This requires that IBM Rational
Application Developer also be updated to version 7.0.0.3. All update tasks are
performed by IBM Installation Manager. If IBM Installation Manager has not
already been started from the Developer for System z Installation Wizard, start
IBM Installation Manager using the startRDzInstall.bat file located in the root
directory of CD1.

The following steps will guide you through the process of updating an existing
IBM Rational Application Developer and WebSphere Developer for System z
installation:

1.
2.

On the main IBM Installation Manager panel, click Update Packages.

You may be prompted to update IBM Installation Manager to a newer version
if one is available. If prompted, click Yes to install the update. Installation
Manager updates itself and informs you that it must restart to complete the
update. Click OK to restart Installation Manager.

After Installation Manager has restarted, you will need to click Update
Packages again.

On the Update Packages panel, select the package group that contains the IBM
Rational Application Developer and WebSphere Developer for System z
installations that you wish to update. Click Next.
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The Updates panel lists the available IBM Rational Application Developer
updates, as well as the WebSphere Developer for System zupdate. Select the
IBM Rational Application Developer and WebSphere Developer for System z
updates for installation and click Next.

On the Licenses panel, read the license agreements for the selected updates.
There are license agreements for each update you selected to install. On the left
side of the License panel, click each package name to display the corresponding
license agreement.

a. If you agree to the terms of all of the license agreements, click I accept the
terms of the license agreements.

b. Click Next to continue.

On the Summary panel, review your choices before you begin installing the
IBM Rational Application Developer and WebSphere Developer for System z
updates. If you want to change the choices you made on previous panels, click
Back and make your changes. When you are satisfied with your installation
choices, click Update to install the updates. The update installations begins and
a progress indicator shows you the percentage of the installation completed.

On the Completion panel, click Finish.

Start the Developer for System z product from the Windows Start menu, via
Start -> All Programs -> [package group name] -> IBM Rational Developer
for System z -> IBM Rational Developer for System z.

Modifying an existing IBM Rational Application Developer installation
to include missing required features

30

Developer for System z requires several features of IBM Rational Application
Developer. If you are installing Developer for System z into a package group that
contains an existing IBM Rational Application Developer installation that is
missing any of the required features, you will need to modify your existing IBM
Rational Application Developer installation prior to installing Developer for System

Z.

Note: If the Installation Wizard does not automatically start the Installation

Manager for you, you can start Installation Manager by running the
startRDzInstall.bat file located in the root directory of CD1.

Note: Modifying an existing IBM Rational Application Developer installation may

require the original IBM Rational Application Developer installation media
and update media to be available in order to install the missing features.

The following steps will guide you through the process of modifying an existing
IBM Rational Application Developer installation:

1.
2.

On the main IBM Installation Manager panel, click Modify Packages.

You may be prompted to update IBM Installation Manager to a newer version
if one is available. If prompted, click Yes to install the update. Installation
Manager updates itself and informs you that it must restart to complete the
update. Click OK to restart Installation Manager. After Installation Manager has
restarted, you will need to click Modify Packages again.

On the Modify Packages panel, select the package group that contains the IBM
Rational Application Developer installation that you wish to modify. Click on
the name of the package group to see what has been installed into it. Click on
the name of the package group to see what has been installed into it. Click
Next.
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4.

5.

7.

On the Languages panel, select or deselect any languages you wish to add to or
remove from your installation.

On the Features panel, select the features that you want to add to your IBM
Rational Application Developer installation. The features that are already
installed will already be selected in the list of features.

You can click on the name of any feature to view a description of that feature.
The feature description will display in the Details section at the bottom of the
panel.

Be sure to select all of the features that are required by Developer for System z.
You may also add any optional features that you would like to install, however
it is recommended that you do not remove any features.

The following IBM Rational Application Developer features are required by
Developer for System z and must be installed:

* Web Development Tools

* J2EE and Web services development tools

* Test and Performance Tools Platform (TPTP)

* J2EE Connector (J2C) tools

* Transformation authoring

¢ Plug-in Development Environment (PDE)

* Data tools

* WebSphere Application Server development tools

¢ WebSphere Application Server compile-time dependencies

On the Summary panel, review your choices before you begin modifying your
IBM Rational Application Developer installation. If you want to change the
choices you made on previous panels, click Back and make your changes.
When you are satisfied with your choices, click Modify to make the changes
you specified to your installation. The modification process begins and a
progress indicator shows you the percentage of the process completed.

On the Completion panel, click Finish.

Updating an existing IBM Rational Application Developer installation to

version 7.0.0.3

If you are installing Developer for System z into a package group with an existing
Rational Application Developer installation, you will be required to update
Rational Application Developer to version 7.0.0.3 before the Developer for System
z installation can proceed. If IBM Installation Manager has not already been started
from the Developer for System z Installation Wizard, start IBM Installation
Manager using the startRDzInstall.bat file located in the root directory of CDI.

The following steps will guide you through the process of updating an existing
IBM Rational Application Developer installation:

1.
2.

On the main IBM Installation Manager panel, click Update Packages.

You may be prompted to update IBM Installation Manager to a newer version
if one is available. If prompted, click Yes to install the update. Installation
Manager will update itself and inform you that it must restart to complete the
update. Click OK to restart Installation Manager. After Installation Manager has
restarted, you will need to click Update Packages again.
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3. On the Update Packages panel, select the package group that contains the
Rational Application Developer installation that you wish to update. Click on
the name of the package group to see what has been installed into it. Click
Next.

4. The Updates panel will list the available Rational Application Developer
update. Select it and then click Next.

5. On the Licenses panel, read the license agreements for the selected update.

a. If you agree to the terms of all of the license agreements, click I accept the
terms of the license agreement.

b. Click Next to continue.

6. On the Summary panel, review your choices before you begin installing the
IBM Rational Application Developer update. If you want to change the choices
you made on previous panels, click Back and make your changes. When you
are satisfied with your installation choices, click Update to install the update.
The update installation begins and a progress indicator shows you the
percentage of the installation completed.

7. On the Completion panel, click Finish.

Installing onto a system that has IBM Rational Application Developer
7.0.0.3 installed

32

If you have an existing Rational Application Developer 7.0.0.3 installation that
includes all of the features required by Developer for System z, you can install
Developer for System z directly into the same package group that contains
Rational Application Developer 7.0.0.3. If IBM Installation Manager has not already
been started from the Developer for System z Installation Wizard, start IBM
Installation Manager using the startRDzInstall.bat file located in the root
directory of CD1.

The following steps will guide you through the process of installing Developer for
System z on a system with an existing Rational Application Developer 7.0.0.3
installation:

1. On the Install Packages panel, select the IBM Rational Developer for System z
offering. If Rational Application Developer 7.0.0.3 also appears on the list of
available packages, deselect it. You do not need to install Rational Application
Developer 7.0.0.3 again. You can click on the name of the offering to view more
information about it. Information is displayed in the Details section at the
bottom of the panel. When you are ready to continue the installation, click
Next. You may be prompted to update IBM Installation Manager to a newer
version if one is available. If prompted, click Yes to install the update.
Installation Manager updates itself and informs you that it must restart to
complete the update. Click OK to restart Installation Manager.

2. On the Licenses panel, read the license agreement for the selected package.

a. If you agree to the terms of all of the license agreements, click I accept the
terms of the license agreement.

b. Click Next to continue.

3. On the Location panel, select the package group that contains your Rational
Application Developer 7.0.0.3 installation as the package group in which to
install Developer for System z 7.1:

a. Click Use the existing package group

b. Click the name of the package group that contains your Rational
Application Developer 7.0.0.3 installation. When you click on a package
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group name, the bottom of the Location panel displays detailed information
about the package group, as well as a list of packages that are currently
installed in that package group. You can verify that you have selected the
correct package group by looking at the Installed Packages section at the
bottom of the panel and verifying that the expected version of Rational
Application Developer is listed as one of the packages installed in the
package group.

c. The name and installation directory for the package group cannot be
changed. These values were defined when you created the package group.

d. Click Next to continue.

4. On the Features panel, select the features of Developer for System z that you

want to install. You can click on the name of any feature to view a description
of that feature. The feature description is displayed in the Details section at the
bottom of the panel. When you have finished selecting the features you want to
install, click Next.

On the Summary panel, review your choices before you begin installing
Developer for System z. If you want to change the choices you made on
previous panels, click Back and make your changes. When you are satisfied
with your installation choices, click Install to install the package. The
installation begins and a progress indicator shows you the percentage of the
installation completed.

When the installation process is completed, a message will confirm the success
of the installation.

a. To view the log file for the current session, click View log file to open the
installation log in a new window.

b. Click Finish and exit the installation.

c. Start the Developer for System z product from the Windows Start menu, via
Start -> All Programs -> [package group name] -> IBM Rational
Developer for System z -> IBM Rational Developer for System z.

Installing onto a system that has IBM Rational Application Developer
at a version later than 7.0.0.3

Rational Application Developer 7.0.0.3 must be installed on the system before
Developer for System z can be installed. If you have an existing installation of
Rational Application Developer at a version later than 7.0.0.3, there may be
additional updates to Developer for System z that must be installed in order to
create a package that is compatible with your version of Rational Application
Developer. If there are updates available, IBM Installation Manager will need to be
able to access them during the Developer for System z installation. You can check
for and obtain updates to Developer for System z using one of the following
methods:

1.

If your system has internet access during the installation, Installation Manager
can check for the latest recommended update and install it directly from the
IBM update repository at the same time Developer for System z v 7.1 is
installed.

If your system does not have internet access during the installation, you will
need to check for the latest recommended update from the Developer for
System z v 7.1 support website, at http://www.ibm.com/software/awdtools/
devzseries/support/. If any updates are available, you will need to download
the update package prior to running the Developer for System z installation
and make the update available to Installation Manager using one of the
following methods:
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* After downloading the update, extract the update repository files to a local
or network location that is accessible to Installation Manager during the
Developer for System z installation.

* After downloading the update, extract the update repository files to a
temporary location and use IBM Packaging Utility to copy the update
package to a local or network update repository. This is useful if you want to
maintain product updates in a network update repository that is accessible to
multiple users. Sed“IBM Packaging Utility” on page 53| for more information
on using IBM Packaging Ultility to create your own update repository.

If there are no updates available, proceed with the Developer for System z
installation.

If the Developer for System z Installation Wizard has not started IBM Installation
Manager, start IBM Installation Manager using the startRDzInstall.bat file
located in the root directory of CD1.

The following steps will guide you through the process of installing Developer for
System z on a system with an existing installation of Rational Application
Developer at a version later than 7.0.0.3:

1. From the main IBM Installation Manager panel:
a. Click File > Preferences.
b. Click Repositories on the left side of the Preferences window.

c. If your system has access to the internet during the Developer for System z
installation, make sure the checkbox labeled Search service repositories
during installation and updates is checked. This tells Installation Manager
to search the IBM update repository for Developer for System z updates.

d. If your system does not have access to the internet during the Developer for
System z installation and you are planning to install the updates directly
from a local or network update repository, download the updates from the
Developer for System z support website and add the repository location in
the Installation Manager Preferences before proceeding with the installation:

1) Click Add Repository.

2) Enter the directory path or URL of the update repository that contains
the Developer for System z updates. Click OK. Installation Manager will
verify that it is able to connect to the specified repository. If Installation
Manager is unable to connect to the repository, an error message is
displayed. If this occurs:

* Be sure you have properly entered the directory path or URL and that
your system is able to access that location.

* If you are behind a firewall, verify that the firewall is not blocking
Installation Manager from accessing the network. The Installation
Manager process that requires network access is called javaw.exe.

e. Click OK to save your preferences and exit the Preferences window.
2. On the main IBM Installation Manager panel, click Install Packages.

3. On the Install Packages panel, Developer for System z is displayed in the list of
available packages. The version of Developer for System z listed may vary
depending on whether you added a new update repository in the Installation
Manager preferences prior to running the installation.

 If you added a local or network update repository in the Installation
Manager preferences, the version of Developer for System z listed on the
Install Packages panel should be the version contained in the update
repository.
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 If you did not add a repository in the Installation Manager preferences, IBM
Rational Developer for System z version 7.1.0 will be the version listed.

If you are connected to the internet and would like Installation Manager to
check for and install updates for you from the IBM update repository, click
Check for Other Versions and Extensions. Installation Manager will search the
update repository for available updates and inform you if any were found.

Note: If Rational Application Developer 7.0.0.3 also appears on the list of
available packages, deselect it. You do not need to install Rational
Application Developer again.

Note: You can click on the name of an offering to view more information about
it. Information is displayed in the Details section at the bottom of the
panel.

When you are ready to continue the installation, click Next.

. On the Licenses panel, read the license agreement for the selected package.

a. If you agree to the terms of the license agreements, click I accept the terms
of the license agreement.

b. Click Next to continue.

. On the Location panel, select the package group that contains your Rational
Application Developer installation as the package group in which to install
Developer for System z:

a. Click Use the existing package group

b. Click the name of the package group that contains your Rational
Application Developer installation. When you click on a package group
name, the bottom of the Location panel displays detailed information about
the package group, as well as a list of packages which are currently
installed in that package group. You can verify that you have selected the
correct package group by looking at the Installed Packages section at the
bottom of the panel and verify that the expected version of Rational
Application Developer is listed as one of the packages installed in the
package group.

c. The name and installation directory for the package group cannot be
changed. These values were defined when you created the package group.

d. Click Next to continue.

. On the Features panel, select the features of Developer for System z that you
want to install. You can click on the name of any feature to view a description
of that feature. The feature description will display in the Details section at the
bottom of the panel.

When you have finished selecting the features you want to install, click Next.
You may see an error message at the top of the Features panel that says, "The
installation package 'IBM Rational Developer for System z’ requires
components supplied by other packages...” followed by a list of the features of
Rational Application Developer that are required by Developer for System z.
This error message indicates one of two things:

a. Your existing Rational Application Developer installation is missing one or
more of the features that are required by Developer for System z. You will
need to modify your existing Rational Application Developer installation to

include the missing features. See|[“Modifying an existing IBM Rationall

Application Developer installation to include missing required features” on|

page 30| for details on how to modify your installation. Note:
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Note: Modifying an existing Rational Application Developer installation
may require the original Rational Application Developer installation
media and update media to be available in order to install the
missing features.

Once you have installed the missing required features, retry the Developer

for System z installation from step 1.

b. Developer for System z is not compatible with the version of Rational
Application Developer that is installed. If you did not check for available
Developer for System z updates, follow the instructions at the beginning of
this section to determine if a Developer for System z update is available. If
you already checked for updates and are attempting to install the latest
available version, then Developer for System z is not compatible with your
version of Rational Application Developer and you cannot install Developer
for System z into the same package group. You will need to do one of the
following:

* Recommended: Install Rational Application Developer 7.0.0.3 and
Developer for System z into a new package group. See |“Installing into a
lnew package group” on page 26| for more information.

* If possible, roll back your Rational Application Developer installation to
version 7.0.0.3 using the Roll Back Packages feature of IBM Installation
Manager. On the Installation Manager main panel, click Roll Back
Packages. Follow the instructions on the panels to roll back Rational
Application Developer to version 7.0.0.3.

Note: Depending on your system configuration, Installation Manager
preferences, and installation history, you may not be able to roll
back Rational Application Developer to version 7.0.0.3.

7. On the Summary panel, review your choices before you begin installing
Developer for System z. If you want to change the choices you made on
previous panels, click Back and make your changes. When you are satisfied
with your installation choices, click Install to install the package. The
installation will begin and a progress indicator will show you the percentage of
the installation completed.

8. When the installation process is complete, a message will confirm the success of
the installation.

a. Click View log file to open the installation log file for the current session in
a new window. You must close the Installation Log window to continue.

b. Click Finish and exit the installation.

c. Start the Developer for System z product from the Windows Start menu.
Select Start -> All Programs -> [package group name] -> IBM Rational
Developer for System z -> IBM Rational Developer for System z.

Updating an existing installation of Rational Software Architect and
WebSphere Developer for System z installation

36

Rational Developer for System z can be installed as an update to an existing
WebSphere Developer for System z Version 7.0.x installation. This requires that
Rational Software Architect also be updated to version 7.0.0.3. All update tasks are
performed by IBM Installation Manager. Rational Software Architect updates are
not included on the Developer for System z installation CDs, so you will need to
obtain the Rational Software Architect 7.0.0.3 one of the following ways:
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* If your system has access to the internet, Installation Manager can install the
Rational Software Architect 7.0.0.3 update directly from the IBM update
repository at the same time it installs Developer for System z.

 If your system does not have internet access or you would rather install Rational
Software Architect 7.0.0.3 from a local or network location, download the
Rational Software Architect 7.0.0.3 update from the Rational Software Architect
support website, at http://www.ibm.com/software/awdtools/architect/
swarchitect/support/index.html. Make the update available to Installation
Manager using one of the following methods:

After downloading the update, extract the update repository files to a local or
network location that is accessible to Installation Manager during the
installation.

After downloading the update, extract the update repository files to a
temporary location and use IBM Packaging Utility to copy the update
package to a local or network update repository. This is useful if you want to
maintain product updates in a network update repository that is accessible to
multiple users. See ['IBM Packaging Utility” on page 53| for more information
on using IBM Packaging Ultility to create your own update repository.

If the Installation Wizard has not started IBM Installation Manager, start
Installation Manager using the startRDzInstall.bat file located in the root
directory of CD1.

The following steps will guide you through the process of updating an existing
Rational Software Architect and Developer for System z installation:

1. 1. From the main IBM Installation Manager panel:

a.

Click File > Preferences.

b. Click Repositories on the left side of the Preferences window.

e

If your system has access to the internet during the installation, make sure
the checkbox labeled Search service repositories during installation and
updates is checked. This tells Installation Manager to search the IBM update
repository for Rational Software Architect updates.

If your system does not have access to the internet during the
&amigshipv_short; installationnstallation and you are planning to install the
update from a local or network update repository, download the Rational
Software Architect 7.0.0.3 update from the support website at
http://www.ibm.com/software/awdtools/architect/swarchitect/support/
index.html and add the repository location in the Installation Manager
Preferences before proceeding with the installation:

1) Click Add Repository.

2) Enter the directory path or URL of the update repository that contains
the Rational Software Architect 7.0.0.3 update. Click OK. Installation
Manager verifies that it is able to connect to the specified repository. If
Installation Manager is unable to connect to the repository, an error
message is displayed. If this occurs:

* Be sure you have properly entered the directory path or URL and that
your system is able to access that location.

* If you are behind a firewall, verify that the firewall is not blocking
Installation Manager from accessing the network. The Installation
Manager process that requires network access is called javaw.exe.

. Click OK to save your preferences and exit the Preferences window

2. On the main IBM Installation Manager panel, click Update Packages.
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3. You may be prompted to update IBM Installation Manager to a newer version
if one is available. If prompted, click Yes to install the update. Installation
Manager updates itself and informs you that it must restart to complete the
update. Click OK to restart Installation Manager. After Installation Manager has
restarted, click Update Packages again.

4. On the Update Packages panel, select the package group that contains the
Rational Software Architect and WebSphere Developer for System z
installations that you wish to update. Click on the name of the package group
to see what has been installed into it. Click Next.

5. The Updates panel lists the available Rational Software Architect 7.0.0.3 and
WebSphere Developer for System z updates. If you do not see Rational
Software Architect 7.0.0.3 listed, click Show all versions to display additional
versions that are available. Select the Rational Software Architect 7.0.0.3 and
IBM Rational Developer for System z updates for installation. Click Next.

6. On the Licenses panel, read the license agreements for the selected updates.
There is a license agreement for each update you selected to install. On the left
side of the License panel, click each package name to display its license
agreement.

a. If you agree to the terms of all of the license agreements, click I accept the
terms of the license agreements.

b. Click Next to continue.

7. On the Summary panel, review your choices before you begin installing the
Rational Application Developer and WebSphere Developer for System z
updates. If you want to change the choices you made on previous panels, click
Back and make your changes. When you are satisfied with your installation
choices, click Update to install the updates. The update installations will begin
and a progress indicator will show you the percentage of the installation
completed.

8. On the Completion panel, click Finish.

9. Start the Developer for System z product from the Windows Start menu. Select
Start -> All Programs -> [package group name] -> IBM Rational Developer
for System z -> IBM Rational Developer for System z.

Modifying an existing Rational Software Architect installation to
include missing required features
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Developer for System z requires several features of Rational Software Architect.
These features must be installed before installing Developer for System z. If you
are installing Developer for System z into a package group that contains an
existing Rational Software Architect installation and any of the required features
are missing, you will need to modify your existing Rational Software Architect
installation to include the missing features.

If the Installation Wizard has not started IBM Installation Manager, start
Installation Manager using the startRDzInstall.bat file located in the root
directory of CD1. Note:

Modifying an existing Rational Software Architect installation may require the
original Rational Software Architect installation media in order to install the
missing features. The following steps will guide you through the process of
modifying an existing Rational Software Architect installation:

1. On the main Installation Manager panel, click Modify Packages.
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. You may be prompted to update IBM Installation Manager if a newer version is

available. If prompted, click Yes to install the update. Installation Manager
updates itself and informs you that it must restart to complete the update.
Click OK to restart Installation Manager. After Installation Manager has
restarted, click Modify Packages again.

. On the Modify Packages panel, select the package group that contains the

Rational Software Architect installation that you wish to modify. Click on the
name of the package group to see what has been installed into it. Click Next.

. On the Languages panel, select or deselect any languages you wish to add to or

remove from your installation.

. On the Features panel, select the features that you want to add to your Rational

Software Architect installation. The features that are already installed are
preselected in the list of features. You can click on the name of any feature to
view a description of that feature. The feature description is displayed in the
Details section at the bottom of the panel. Be sure to select all of the features
that are required by Developer for System z. You may also add any additional
features that you would like to install, however it is recommended that you do
not remove any features.

The following Rational Software Architect features are required by Developer
for System z and must be installed:

* UML Modeling
* UML-to-UML transformations and patterns

J2EE and Web services development tools

*  Web Development Tools

* J2EE Connector (J2C) tools

* Test and Performance Tools Platform (TPTP)

* Plug-in Development Environment (PDE)

 Data tools

* WebSphere Application Server development tools

* WebSphere Application Server compile-time dependencies

. On the Summary panel, review your choices before you begin modifying your

Rational Software Architect installation. If you want to change the choices you
made on previous panels, click Back and make your changes. When you are
satisfied with your choices, click Modify to make the changes you specified to
your installation. The modification process begins and a progress indicator
shows the percentage of the process completed.

. On the Completion panel, click Finish.

Updating an existing Rational Software Architect installation to version

7.0.0.3

If you are installing Developer for System z into a package group with an existing
Rational Software Architect installation, you will be required to update Rational
Software Architect to version 7.0.0.3 before the Developer for System z installation
can proceed. Rational Software Architect updates are not included on the
Developer for System z installation CDs, so you will need to obtain the Rational
Software Architect 7.0.0.3 one of the following ways:

. If your system has access to the internet, Installation Manager can install the

Rational Software Architect 7.0.0.3 update directly from the IBM update
repository at the same time it installs Developer for System z.
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2. If your system does not have internet access or you would rather install
Rational Software Architect 7.0.0.3 from a local or network location, download
the Rational Software Architect 7.0.0.3 update from the Rational Software
Architect support website, at http://www.ibm.com/software/awdtools/
architect/swarchitect/support/index.html. Make the update available to
Installation Manager using one of the following methods:

After downloading the update, extract the update repository files to a local
or network location that is accessible to Installation Manager during the
installation.

After downloading the update, extract the update repository files to a
temporary location and use IBM Packaging Utility to copy the update
package to a local or network update repository. This is useful if you want to
maintain product updates in a network update repository that is accessible to
multiple users. See|“IBM Packaging Utility” on page 53|for more information
on using IBM Packaging Utility to create your own update repository.

If the Installation Wizard has not started IBM Installation Manager, start IBM
Installation Manager using the startRDzInstall.bat file located in the root
directory of CD1.

The following steps guide you through the process of updating an existing
Rational Software Architect installation:

1. From the main IBM Installation Manager panel:

a.
b.
c.

e.

Click File > Preferences.
Click Repositories on the left side of the Preferences window.

If your system has access to the internet during the installation, make sure
the checkbox labeled Search service repositories during installation and
updates is checked. This tells Installation Manager to search the IBM update
repository for Rational Software Architect updates.

If your system does not have access to the internet during the
&amigshipv_short; installationnstallation and you are planning to install the
update from a local or network update repository, download the Rational
Software Architect 7.0.0.3 update from the support website at
http://www.ibm.com/software/awdtools/architect/swarchitect/support/
index.html, and add the repository location in the Installation Manager
Preferences before proceeding with the installation:

1) Click Add Repository.

2) Enter the directory path or URL of the update repository that contains
the Rational Software Architect 7.0.0.3 update. Click OK. Installation
Manager will verify that it is able to connect to the specified repository.
If Installation Manager is unable to connect to the repository, an error
message is displayed. If this occurs:

* Be sure you have properly entered the directory path or URL and that
your system is able to access that location.

* If you are behind a firewall, verify that the firewall is not blocking
Installation Manager from accessing the network. The Installation
Manager process that requires network access is called javaw.exe.

Click OK to save your preferences and exit the Preferences window.

2. On the main IBM Installation Manager panel, click Update Packages.

3. You may be prompted to update IBM Installation Manager to a newer version
if one is available. If prompted, click Yes to install the update. Installation
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8.

Manager updates itself and informs you that it must restart to complete the
update. Click OK to restart Installation Manager. After Installation Manager has
restarted, click Update Packages again.

On the Update Packages panel, select the package group that contains the
Rational Software Architect installation that you wish to update. Click on the
name of the package group to see what has been installed into it. Click Next.

The Updates panel will list the available Rational Software Architect 7.0.0.3
update. Select it and then click Next.

On the Licenses panel, read the license agreements for the selected update.

a. If you agree to the terms of all of the license agreements, click I accept the
terms of the license agreement.

b. Click Next to continue.

On the Summary panel, review your choices before you begin installing the
Rational Software Architect 7.0.0.3 update. If you want to change the choices
you made on previous panels, click Back and make your changes. When you
are satisfied with your installation choices, click Update to install the update.
The update installation will begin and a progress indicator will show you the
percentage of the installation completed.

On the Completion panel, click Finish.

Installing onto a system that has Rational Software Architect 7.0.0.3

installed

If you have an existing Rational Software Architect 7.0.0.3 installation that includes
all of the features required by Developer for System z, you can install Developer
for System z directly into the same package group that contains Rational Software
Architect 7.0.0.3.

If the Installation Wizard has not started IBM Installation Manager, start IBM
Installation Manager using the startRDzInstall.bat file located in the root
directory of CD1.

The following steps guide you through the process of installing Developer for
System z on a system with an existing Rational Software Architect 7.0.0.3
installation:

1.

On the Install Packages panel, select the IBM Rational Developer for System z
offering. If Rational Software Architect 7.0.0.3 also appears on the list of
available packages, deselect it. You do not need to install Rational Software
Architect 7.0.0.3 again.

You can click on the name of the offering to view more information about it.
Information will be displayed in the Details section at the bottom of the panel.

When you are ready to continue the installation, click Next.
On the Licenses panel, read the license agreement for the selected package.

a. If you agree to the terms of the license agreements, click I accept the terms
of the license agreement.

b. Click Next to continue.

On the Location panel, select the package group that contains your Rational
Software Architect 7.0.0.3 installation as the package group in which to install
Developer for System z:

a. Click Use the existing package group

IBM Rational Developer for System z Version 7.1 Installation Guide 41



b. Click the name of the package group that contains your Rational Software
Architect 7.0.0.3 installation. When you click on a package group name, the
bottom of the Location panel displays detailed information about the
package group, as well as a list of packages which are currently installed in
that package group.

You can verify that you have selected the correct package group by looking
at the Installed Packages section at the bottom of the panel and verifying
that the expected version of Rational Software Architect is listed as one of
the packages installed in the package group.

c. The name and installation directory for the package group cannot be
changed. These values were defined when you created the package group.

d. Click Next to continue.

4. On the Features panel, select the features of IBM Rational Developer for System
z that you want to install. The feature description displays in the Details
section at the bottom of the panel. When you have finished selecting the
features you want to install, click Next.

5. On the Summary panel, review your choices before you begin installing
Developer for System z. If you want to change the choices you made on
previous panels, click Back and make your changes. When you are satisfied
with your installation choices, click Install to install the package. The
installation begins and a progress indicator shows you the percentage of the
installation completed.

6. When the installation process is complete, a message confirms the success of
the installation.
a. Click View log file to open the installation log file for the current session in
a new window.
b. Click Finish and exit the installation.

c. Start the Developer for System z product from the Windows Start menu.
Select Start -> All Programs -> [package group name] -> IBM Rational
Developer for System z -> IBM Rational Developer for System z.

Installing onto a machine that has Rational Software Architect at a
version later than 7.0.0.3
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Rational Software Architect 7.0.0.3 must be installed on the system before
Developer for System z can be installed. If you have an existing installation of
Rational Software Architect at a version later than 7.0.0.3, there may be additional
updates to Developer for System z that must be installed in order to create a
package that is compatible with your version of Rational Software Architect. If
there are updates available, IBM Installation Manager will need to be able to access
them during the Developer for System z installation. You can check for and obtain
Developer for System z updates using one of the following methods:

1. If your system has internet access during the installation, Installation Manager
can check for the latest recommended update and install it directly from the
IBM update repository at the same time Developer for System z is installed.

2. If your system does not have internet access during the installation, you will
need to check for the latest recommended update from the Developer for
System z support website, at http://www.ibm.com/software/awdtools/
devzseries/support/. If any updates are available, download the update
package prior to running the Developer for System z installation. Make the
update available to Installation Manager using one of the following methods:
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* After downloading the update, extract the update repository files to a local
or network location that is accessible to Installation Manager during the
Developer for System z installation.

+ After downloading the update, extract the update repository files to a
temporary location and use IBM Packaging Utility to copy the update
package to a local or network update repository. This is useful if you want to
maintain product updates in a network update repository that is accessible to
multiple users. See [“IBM Packaging Utility” on page 53|for more information
on using IBM Packaging Ultility to create your own update repository.

If there are no updates available, proceed with the Developer for System z
installation.

If the Installation Wizard has not started IBM Installation Manager, start IBM
Installation Manager using the StartIMSetup.bat file located in the root directory
of CD1.

The following steps guide you through the process of installing Developer for
System z on a system with an existing installation of Rational Software Architect at
a version later than 7.0.0.3:

1. From the main IBM Installation Manager panel:
a. Click File > Preferences.
b. Click Repositories on the left side of the Preferences window.

c. If your system has access to the internet during the Developer for System z
installation, make sure the checkbox labeled Search service repositories
during installation and updates is checked. This tells Installation Manager
to search the IBM update repository for Developer for System z updates.

d. If your system does not have access to the internet during the
&amigshipv_short; installationnstallation and you are planning to install the
updates directly from a local or network update repository, download the
updates from the Developer for System z support website and add the
repository location in the Installation Manager Preferences before
proceeding with the installation:

1) Click Add Repository.

2) Enter the directory path or URL of the update repository that contains
the Developer for System z updates. Click OK. Installation Manager
verifies that it is able to connect to the specified repository. If Installation
Manager is unable to connect to the repository, an error message is
displayed. If this occurs:

* Be sure you have properly entered the directory path or URL and that
your system is able to access that location.

¢ If you are behind a firewall, verify that the firewall is not blocking
Installation Manager from accessing the network. The Installation
Manager process that requires network access is called javaw.exe.

e. Click OK to save your preferences and exit the Preferences window.
2. On the main IBM Installation Manager panel, click Install Packages.

3. On the Install Packages panel, IBM Rational Developer for System z is
displayed in the list of available packages. The version of Developer for System
z listed may vary depending on whether you added a new update repository
in the Installation Manager preferences prior to running the installation.
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* If you added a local or network update repository in the Installation
Manager preferences, the version of Developer for System z listed on the
Install Packages panel should be the version contained in the update
repository.

 If you did not add a repository in the Installation Manager preferences,
Developer for System z will be the version listed.

If you are connected to the internet and would like Installation Manager to
check for install updates from the IBM update repository, click Check for Other
Versions and Extensions. Installation Manager searches the update repository
for available updates and informs you if any were found.

Note: If Rational Application Developer or Rational Software Architect also
appear on the list of available packages, deselect it. You do not need to
install Rational Application Developer or Rational Software Architect
again.

You can click on the name of an offering to view more information about it.

Information is displayed in the Details section at the bottom of the panel. When

you are ready to continue the installation, click Next.

. On the Licenses panel, read the license agreement for the selected package.

a. If you agree to the terms of all of the license agreements, click I accept the
terms of the license agreement.

b. Click Next to continue.

. On the Location panel, select the package group that contains your Rational

Software Architect installation as the package group in which to install
Developer for System z:

a. Click Use the existing package group

b. Click the name of the package group that contains your Rational Software
Architect installation. When you click on a package group name, the bottom
of the Location panel displays detailed information about the package
group, as well as a list of packages which are currently installed in that
package group. You can verify that you have selected the correct package
group by looking at the Installed Packages section at the bottom of the
panel and verify that the expected version of Rational Software Architect is
listed as one of the packages installed in the package group.

c. The name and installation directory for the package group cannot be
changed. These values were defined when you created the package group

d. Click Next to continue.

. On the Features panel, select the features of Developer for System z that you

want to install. You can click on the name of any feature to view a description
of that feature. The feature description will display in the Details section at the
bottom of the panel.

When you have finished selecting the features you want to install, click Next.
You may see an error message at the top of the Features panel that says, "The
installation package 'IBM Rational Developer for System z’ requires
components supplied by other packages...” followed by a list of the features of
Rational Software Architect that are required by Developer for System z. This
error message indicates one of two things:

a. Your existing Rational Software Architect installation is missing one or more
of the features that are required by Developer for System z. You will need
to modify your existing Rational Software Architect installation to include
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the missing features. See [“Modifying an existing Rational Software Architect]
[installation to include missing required features” on page 38|for details on
how to modify your installation.

Note: Modifying an existing Rational Software Architect installation may
require the original Rational Software Architect installation media to
be available in order to install the missing features.

Once you have installed the missing required features, retry the Developer

for System z installation from step 1.

b. Developer for System z is not compatible with the version of Rational
Software Architect that is installed. If you did not check for available
Developer for System z updates, follow the instructions at the beginning of
this section to determine if a Developer for System z update is available. If
you already checked for updates and are attempting to install the latest
available version, then Developer for System z is not compatible with your
version of Rational Software Architect and you cannot install Developer for
System z into the same package group. You will need to do one of the
following:

¢ Recommended: Install Rational Software Architect 7.0.0.3 and Developer
for System z into a new package group. See [“Installing into a new]|
[package group” on page 26| for more information.

* If possible, roll back your Rational Software Architect installation to
version 7.0.0.3 using the Roll Back Packages feature of IBM Installation
Manager. On the Installation Manager main panel, click Roll Back
Packages. Follow the instructions on the panels to roll back Rational
Software Architect to version 7.0.0.3.

Note: Depending on your system configuration, Installation Manager
preferences, and installation history, you may not be able to roll
back Rational Software Architect to version 7.0.0.3.

7. On the Summary panel, review your choices before you begin installing
Developer for System z. If you want to change the choices you made on
previous panels, click Back and make your changes. When you are satisfied
with your installation choices, click Install to install the package. The
installation begins and a progress indicator shows the percentage of the
installation completed.

8. When the installation process is complete, a message confirms the success of
the installation.

a. Click View log file to open the installation log file for the current session in
a new window.

b. Click Finish and exit the installation.

c. Start the Developer for System z product from the Windows Start menu.
Select Start -> All Programs -> [package group name] -> IBM Rational
Developer for System z -> IBM Rational Developer for System z.

Installing silently

You can install the IBM Rational Application Developer and IBM Rational
Developer for System z packages by running Installation Manager in silent mode.
When you run Installation Manager in silent mode, its user interface is not
available; you instead use a response file to input the commands required to install
the package.
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Running Installation Manager in silent mode is helpful because it allows you to
use a batch process to install, update, modify and uninstall packages through
scripts.

Note that you must install Installation Manager before you can silently install the
IBM Rational Application Developer and IBM Rational Developer for System z
packages. Refer to [“Installing Installation Manager” on page 17| for details on
installing Installation Manager. You can install Installation Manager either
interactively or silently.

There are three main tasks for silent installation:
1. Create an installation repository using the IBM Packaging Utility.
2. Create the response file.

3. Run Installation Manager in silent install mode.

Creating an installation repository using the IBM Packaging

Utility
Before you create a response file and use it to run silent installations, you need to
create an installation repository using the IBM Packaging Utility. The installation
repository will contain the IBM Rational Application Developer and IBM Rational
Developer for System z install packages. Your repository can be created on a local
drive, a shared network drive, or an HTTP or HTTPS server that is accessible to
other users on your network. Refer to [“IBM Packaging Utility” on page 53| for
details on using the Packaging Utility to create an installation repository.

Creating a response file

You can create a response file by recording your actions as you install the IBM
Rational Application Developer and IBM Rational Developer for System z packages
using Installation Manager. When you record a response file, all of the selections
that you make in the Installation Manager GUI are stored in an XML file. When
you run Installation Manager in silent mode, Installation Manager uses the XML
response file to locate the repository containing the package, select the features to
install, and so on.

To record a response file for installation (or uninstallation):

1. On a command line, change to the eclipse subdirectory in the directory where
you installed Installation Manager. For example: cd C:\Program
Files\IBM\Installation Manager\eclipse

2. On a command line, type the following command to start installation manager,
substituting your own name and location for the response file and (optionally)
the log file:

launcher.bat -record <response file path and name>.xml
-log <log file path and name>.xml

For example,

Tauncher.bat -record [response file path and name].xml
-log [log file path and name].xml

Note: Ensure the file paths you enter exist. Installation Manager will not create
directories for the response file and the log file.

3. Install the IBM Rational Application Developer and IBM Rational Developer for
System z packages using the Installation Manager GUL

4. Exit Installation Manager.
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After you exit Installation Manager, an XML response file is created and resides in
the location specified in the command you use to launch Installation Manager.

A sample response file which can be used to install IBM Rational Application

Developer and IBM Rational Developer for System z is provided on the first IBM

Rational Developer for System z installation CD in the Silent Install directory. You

can copy this file to the location where you created your installation package

repository and use it to perform silent installations. Alternatively, you can copy

this file to a different location and refer to|“Silent installation commands” on pagel
for information on setting the repository location inside the response file.

Running Installation Manager in silent installation mode

You can run Installation Manager in silent installation mode from a command line.

Refer to the Installation Manager online help for additional documentation on how
to run it in silent mode.

You run Installation Manager in silent mode by appending the -silent argument to
the Installation Manager start command launcher.bat

launcher.bat -silent [arguments]

The following table describes the arguments used with the silent installation
command:

Table 3.

Argument |Description

-input Specifies an XML response file as the input to Installation Manager. A
response file contains commands that Installation Manager runs.

-log (Optional) Specifies a log file that records the result of the silent installation.
The log file is an XML file.

To run Installation Manager in silent installation mode:

1. On a command line, change to the eclipse subdirectory in the directory where
you installed Installation Manager. For example: cd C:\Program
Files\IBM\Installation Manager\eclipse

2. Enter and run the following command, substituting your own locations for the
response file and, optionally, the log file: For example, Tauncher.bat -silent
-input c:\mylog\responsefile.xml -log c:\mylog\silent install Tog.xml

Installation Manager runs in silent installation mode; it reads the response file and
writes a log file to the directory you specified. You must have a response file when
running in silent installation mode, log files are optional. A successful install ends
in a return code of 0. If the install ends with a non-zero number, the install failed If
you receive a non-zero return code, check the response file and log file for possible
causes of the failure. See[“Silent install log files” on page 52| for more information
about log files.

Response file commands

If you want to use the silent installation capabilities of Installation Manager, you
need to create a response file that contains all of the commands that Installation
Manager must run. The recommended way to do this is to create a response file by
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recording your actions as you install the IBM Rational Application Developer and
IBM Rational Developer for System z packages. However, you can create or edit a

response file manually.

There are two categories of commands for the response file:

* Preference commands are used to set preferences that are found in Installation
Manager under File -> Preferences..., such as repository location information.

¢ Silent installation commands are used to emulate the Install Packages wizard in

Installation Manager.

Silent install preference commands

While you typically specify preferences using the Preferences window, you can also
specify preferences (identified as keys) in a response file for use during a silent

installation.

Note: You can specify more than one preference in a response file.

When you define preferences in a response file, your XML code will look similar to

the following example:

<preference>
name = "the key of the preference"

value = "the value of the preference to be set"

</preferences>

Use the following table to identify keys and their associated values for silent

installation preferences:

Table 4.

Key

Value

Notes

com.ibm.cic.common.core.preferences.logLocation

Specifies the
location of
Installation
Manager log file.

Important: This
key is optional
and is designed
for testing and
debugging. If you
do not specify a
location for the log
file, both silent
installation and
the Ul version of
Installation
Manager will use
the same location.

com.ibm.cic.license.policy.location

Specifies a URL
that defines
where the remote
license policy file
resides.

com.ibm.cic.common.core.preferences.

http.proxyEnabled

True or

False is the default
value.

com.ibm.cic.common.core.preferences.
http.proxyHost Host name or IP address

Host name or IP
address

com.ibm.cic.common.core.preferences.
http.proxyPort

Port number

com.ibm.cic.common.core.preferences.
http.proxyUseSocks

True or False

False is the default
value.
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Table 4. (continued)

Key

Value

Notes

com.ibm.cic.common.core.preferences.
SOCKS.proxyHost

Host name or IP
address

com.ibm.cic.common.core.preferences.
SOCKS.proxyPort

Port number

com.ibm.cic.common.core.preferences.
ftp.proxyEnabled

True or False

False is the default
value.

com.ibm.cic.common.core .preferences.
ftp.proxyHost

Host name or IP
address

com.ibm.cic.common.core.preferences.
ftp.proxyPort

Port number

com.ibm.cic.common.core.preferences.eclipseCache

c:\IBM\common
Note: The paths
above are default
values for this
preference;
typically, install
packages provide
their own values
for this
preference

You cannot change
this location if you
have already
installed a
package.

com.ibm.cic.agent.core.pref.offering.service.repositori

cErae UseHalse

Change this
preference to
"False’ to disable
it. When "True’, all
linked repositories
are searched when
products are
installed or
updated.

com.ibm.cic.common.core.preferences.preserveDown|

| dadedoxriitdses

Change this
preference to
"False’ to disable
it. When true, the
files required to
roll the package
back to a previous
version are stored
on your system.
When false, these
files are not
stored. If you do
not store these
files, you must
connect to your
original repository
or media to roll
back.

Silent installation commands

You can use this reference table to learn more about response file commands for

use during a silent installation.
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Table 5.

Response file commands

Description

Set profile

<profile id="the profile
(package group) id"
installLocation="the install
location of the profile">
<data key="keyl" value="valuel"/>
<data key="key2" value="value2"/>
</profile>

Use this command to create a package
group (or installation location). If the
specified package group already exists,
the command has no effect. Currently,
when creating the profile, the silent
installation will also create two installation
contexts; one for Eclipse and one for
native. A profile is an installation location.

You can use the <data> element for setting
profile properties.

The following list contains the currently
supported keys and related values:

* The eclipselocation key specifies an
existing Eclipse location value, such as
c:\myeclipse\eclipse

e The cic.selector.nl key specifies the
Natural Language (NL) locale
selections, such as zh, ja, and en.

Note: Separate multiple NL values with
commas.

The following list contains the currently
supported language codes:

* English (en)

e French (fr)

 Simplified Chinese (zh)

» Traditional Chinese (Taiwan) (zh_TW)
* German (de)

* Japanese (ja)

* Spanish (es)

* Korean (ko)

* Portuguese (pt_BR)

Set repositories

<server>

<repository
location="http:/xxx/repository/">

<repository
location="file:/C:/repository/">

<!--add more repositories below>

<-.u>

</server>

Use this command to specify the
repositories used during a silent
installation. Each repository location can
be a URL or a file path.
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Table 5. (continued)

Response file commands

Description

Install

<install>

<offering profile= "profile id"
features= "feature ids"

id= "offering id"

version= "offering version">
</offering>

<!--add more offerings below>
<...>

</install>

Use this command to specify the
installation packages that will be installed.

The profile ID must match an existing
profile or a profile created by the set
profile command.

Feature IDs can be optionally specified by
a comma-delimited list, such as "featurel,
feature2” and so on. If no feature IDs are
specified, all the default features in the
specified offering will be installed.

Note: Required features will be included
for installation, even if they are not
explicitly specified in the
comma-delimited list.

<install modify="true"> or <uninstall
modify="true"> (optional attribute)

<uninstall modify="true">
<offering
profile="profileID"id="1Id"
version="Version"
features="-"/>
</uninstall>

Use the <install modify="true">
attribute on install and uninstall
commands to indicate that you want to
modify an existing install. If the attribute
is not set to true, the value defaults to
false. If the intent of the modify operation
is only to install additional language
packs, then a hyphen “-* should be used
in the offering feature id list to indicate no
new features are being added.

Important: You must specify
"modify=true" and a hyphen "-" feature
list as specified in the example; otherwise,
the install command will install the
offering’s default features and the
uninstall command will remove all the
features.

"_n

Uninstall

<uninstall>

<offering profile= "profile id"
features= "feature ids"

id= "offering id"

version= "offering version">
</offering>

<!--add more offerings below>
<...>

</uninstall>

Use this command to specify the
installation packages that will be
uninstalled.

The profile ID must match an existing
profile or a profile specified in a profile
command. Further, if there are no feature
IDs specified, all the features in the
specified offering will be uninstalled; if
there are no offering IDs specified, all the
installed offering in the specified profile
will be uninstalled.

Rollback

<rollback>
<offering profile= "profile id"
id= "offering id"
version= "offering version">
</offering>

<!--add more offerings below>
<...>

</rollback>

Use this command to roll back to the
specified offerings from the version
currently installed on the specified profile.
You cannot specify features in a roll back
command.
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Table 5. (continued)

Response file commands Description

InstallAll Use this command to silently search for

<installALL/> and install all available installable
packages.

Note: This command is equivalent to using
-silent -installAll

UpdateAll Use this command to silently search for
<updateALL/> and update all available installable
packages.

Note: This command is equivalent to using

-silent -updateAll

Reference: Sample response file

You can use an XML-based response file to specify predefined information such as
silent installation preferences, repository locations, package groups and so on.
Response files are beneficial for teams and companies that want to install
installation packages silently and to standardize the locations and preferences for
installation packages.

Sample response file

<agent-input >
<!-- add preferences -->
<preference name="com.ibm.cic.common.core.preferences.http.proxykEnabled"
value="c:/temp"/>
<l-- create the profile if it doesn't exist yet -->
<profile id="my_profile" installlLocation="c:/temp/my_profile"></profile>
<server>
<repository
location=
"http://a.site.com/Tocal/products/sample/20060615_1542/repository/">
</repository>/server>

<install>

<offering profile= "my profile" features= "core" id= "ies"
version= "3.2.0.20060615"> </offering>

</install>

</agent-input>

Silent install log files

You can use silent install log files to examine the results of a silent installation
session.

The silent installation functionality creates an XML-based log file that records the
result of the silent install execution (as long as a log file path is specified using -log
<your log file path>.xml). If your silent installation session is successful, the log
file will contain just the root element of <result> </result>. However, if there
errors occur during the installation, the silent install log file will contain error
elements with messages such as:
<result>

<error> Cannot find profile: profile id</error>

<error> some other errors</error>
</result>
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For detail analysis, you can look at the logs generated in the Installation Manager
data area. By using a preference command, you can optionally set the data area to
your preferred location, as shown in the response file topic.

Running Installation Manager in wizard mode

Wizard mode starts Installation Manager in either the install wizard or the
uninstall wizard with your preferences and install or uninstall choices already set
based on the specified response file. The response file can only contain preference
commands and install or uninstall commands. You can not mix install and
uninstall commands in the same response file when you run Installation Manager
in wizard mode.

Enter the following command on the command line to start Installation Manager in
wizard mode.

launcher -mode wizard -input <response file>

IBM Packaging Utility

You can use the IBM Packaging Utility software to copy packages to a repository
that can be placed on a Web server available over HTTP or HTTPS.

The Packaging Utility software is included on the IBM Rational Auxiliary CD. If
you want place a repository containing the a IBM Rational Application Developer
and IBM Rational Developer for System z packages on a Web server available over
HTTP, then you must use the Packaging Utility to copy the packages into the
repository.

You can use this utility to perform the following tasks:
* Generate a new repository for packages.

* Copy packages to a new repository. You can copy multiple packages into a
single repository, thereby creating a common location in your enterprise from
which products can be installed using IBM Installation Manager.

* Delete packages from a repository.

Refer the online help for the Packaging Utility for full instructions on using the
tool.

Installing the Packaging Utility

The IBM Packaging Utility must be extracted from a compressed file before it can
be used to copy the IBM Rational Application Developer and IBM Rational
Developer for System z packages.

Use the following steps to extract the IBM Packaging Utility software:

1. Locate the Packaging Utility compressed file on the IBM Rational Auxiliary CD.
The compressed file containing the Packaging Ultility is located on the IBM
Rational Application Developer auxiliary CD.

* PackagingUtility\pu.disk win32.zip
2. Extract the files from the compressed file containing the utility into a temporary

directory. Be sure to preserve the directory of the compressed files. These are
the installation files you will use to install the Packaging Ultility.

3. Change to the directory where you extracted the Packaging Utility installation
files and start the installation program.

4. Run install_win32.exe.
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5. If IBM Installation Manager is not detected on your workstation, you are
prompted to install it and then the installation wizard starts. Follow the
on-screen instructions in the wizard to complete the installation of Installation
Manager. See [“Installing Installation Manager” on page 17] for details.

6. When the installation of Installation Manager completes, or if it is already on
your computer, Installation Manager starts and automatically begins the Install
Packages wizard.

7. Follow the on-screen instructions in the Install Packages wizard to complete the
installation.

Copying packages to a HTTP server using the Packaging

If you want to create a repository on a HTTP server, then you must use the
Packaging Utility to copy the IBM Rational Application Developer and IBM
Rational Developer for System z packages.

Note that this method does not copy the additional software included with the
IBM Rational Developer for System z installation image. Only the IBM Rational
Application Developer and IBM Rational Developer for System z packages that are
installed using IBM Installation Manager are copied.

Note also that the Packaging Utility can be used to combine multiple product
packages, as well as service updates, into a single repository location. Refer to the
Packaging Utility online help for more information.

To copy packages with the packaging utility:
1. If you are copying from a CD images

a. Insert the IBM Rational Developer for System z and IBM Rational Application
Developer Installation CD 1 into your disk drive.

b. If autorun is enabled on your system, the IBM Rational Developer for
System z launchpad program automatically opens. Close the launchpad
program.

2. Start the packaging utility.
3. On the main page of the utility, click Copy Package. The Prerequisite page
opens and presents you with two options:

* I will be downloading packages from IBM Web

* I will be obtaining the packages from other sources

4. Click I will be downloading packages from IBM Web.

Note: You can use the I will be obtaining the packages from other sources
option if you have already defined an accessible repository.

5. Click Next to advance to the Source page.

6. To open a repository, click Open repository. The Open Repository window
opens.

7. To define the repository location, click Browse, and then navigate to and
select the Repository location - either the common root directory that contains
the electronic disk images or the drive containing the first product installation
CD. For example, if the Developer for System z files (disk1, disk2, and so on)
reside in C:\My product\unzip, you should define this location as a repository.

8. Click OK to define the repository location and to close the Browse to a
repository directory window.
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9. Select the IBM Rational Application Developer 7.0.0.3 and IBM Rational
Developer for System z version 7.1 packages to be copied to the repository.

10. On the Licenses panel, read the license agreements for the selected updates.
There will be a license agreement for each update you selected to install. On
the left side of the License panel, click each package name to display its
license agreement.

a. If you agree to the terms of all of the license agreements, click I accept the
terms of the license agreements.

b. Click Next to continue.

11. On the Destination page, click the Browse button and select an existing
repository directory, or create a new folder to store the products.

12. Once you select a destination repository, click OK to close the Browse to a
directory window. The file path that you just defined is listed in the Directory
field on the Destination page.

13. Click Next to advance to the Summary page. The Summary page displays the
selected packages that will be copied into the destination repository. This page
also lists the amount of storage space that the copy requires, as well as the
amount of available space on the drive.

14. Click Copy to copy the selected packages to the destination repository. A
status bar appears at the bottom of the wizard indicating how much time is
remaining in the copy process. Once the copy process is finished, a Complete
page opens and displays all of the packages that were copied successfully.

15. Click Done to return to the Packaging Utility main page.

Now that you have used the Packaging Utility to copy the IBM Rational
Application Developer and IBM Rational Developer for System z installation files
into a repository, you can place the repository on a Web server and making the
directories and files available over HTTP or HTTPS. (The repository can also be
placed on a UNC drive.)

Managing licenses

You can manage the licensing for your installed products and customized packages
by using the Manage Licenses wizard and associated Preferences pages. The
Manage Licenses wizard displays license type and license expiration information
for each of your installed packages.

IBM Rational Developer for System z and IBM Rational Application Developer
install trial licenses which time out 60 days after installation. You will need to
upgrade the trial licenses of IBM Rational Developer for System z and IBM
Rational Application Developer by importing the product activation kit from the
IBM Rational Developer for System z and IBM Rational Application Developer
activation kit CD after you install the products.

License enablement

Activation kits

Product activation kits contain the permanent license keys for your trial Rational
products. You import the activation kit to your product by using IBM Installation
Manager. Refer to |“Importing the IBM Rational Developer for System z product]
activation kit” on page 56/and ["Importing the IBM Rational Application Developer|
product activation kit” on page 56| for details.
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Viewing license information for installed packages

You can review license information for your installed packages, including license
types and expiration dates, from IBM Installation Manager.

To view license information:
1. Start IBM Installation Manager.
2. On the main page, click Manage Licenses.

The package vendor, current license types, and expiration dates are displayed for
each installed package.

Importing the IBM Rational Developer for System z product
activation kit

After you install IBM Rational Developer for System z, you will need to upgrade
the IBM Rational Developer for System z trial license to a permanent license by
importing the product activation kit. You must use IBM Installation Manager to
import the activation kit. The IBM Rational Developer for System z product
activation kit is located on the IBM Rational Developer for System z and IBM
Rational Application Developer Activation kit CD. To import the activation kit and
enable the new license key:

1. Start IBM Installation Manager
2. On the main page, click Manage Licenses.

3. On the Install Packages page, select the IBM Rational Developer for System z
package and click Import product enablement kit

4. Click Next. Details for the selected package are displayed, including the current
license kind and the version range the license applies to.

5. Browse to the RDzlic.jar file on the Activation kit CD. ClickOpen.

6. Click Next. The Summary page displays the target install directory for the
activation kit, the product the new license applies to, and version information.

7. Click Finish.

The product activation kit with its permanent license key is imported to the
product. The Manage Licenses wizard indicates whether or not the import was
successful.

Importing the IBM Rational Application Developer product
activation kit

After you install IBM Rational Application Developer, you will need to upgrade
the IBM Rational Application Developer trial license to a permanent license by
importing the product activation kit. The IBM Rational Application Developer
product activation kit is located on the IBM Rational Developer for System z and
IBM Rational Application Developer Activation kit CD. To install the permanent
license, you need to import the kit using IBM Installation Manager. To import the
activation kit and enable the new license key:

1. Start IBM Installation Manager.
2. On the main page, click Manage Licenses.

3. On the Install Packages page, select a IBM Rational Application Developer and
click Import product enablement kit.

4. Click Next. Details for the selected package are displayed, including the current
license kind and the version range the license applies to.
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5. Browse to the RAD1ic.jar file on the Activation kit CD. Click Open.

6. Click Next. The Summary page displays the target install directory for the
activation kit, the product the new license applies to, and version information.

7. Click Finish.

The product activation kit with its permanent license key is imported to the
product. The Manage Licenses wizard indicates whether or not the import was
successful.

Silently installing the product activation kit

Product activation kits can also be installed silently just like the products
themselves. The only difference is that a product activation kit is stored in a
compressed repository, so the repository to which you will point IBM Installation
Manager will be the compressed repository file rather than a directory. You will
need to generate a response file to be used by IBM Installation Manager to install
the product activation kit. Refer to [“Installing silently” on page 45 for details on
recording a response file and running silent installations. When recording your
response file, follow the steps provided in|“Importing the IBM Rational Developer
for System z product activation kit” on page 56/and [“Importing the IBM Rational|
Application Developer product activation kit” on page 56| to import the product
activation kits. Your actions will be recorded in the response file, which can then
be used to silently install the Developer for System z and IBM Rational Application
Developer product activation kits on other systems.

Starting IBM Rational Developer for System z

You can start IBM Rational Developer for System z from the Windows desktop
environment or the command-line interface.

* To start IBM Rational Developer for System z from the Windows Start menu,
click Start > Programs > (Package Group Name) > IBM Rational Developer for
System z -> IBM Rational Developer for System z

* To start IBM Rational Developer for System z from the command line, type:
<product install directory>\eclipse.exe -product
com.ibm.websphere.developer.systemz.ide

Modifying installations

The IBM Installation Manager Modify Packages allows you to change the content
of the installed packages by adding or removing features. This functionality is
available only on packages that have been installed using the IBM Installation
Manager.

You may need access to the original installation media and update media to
modify your installation. See the Installation Manager help for more information.

Note: Close all programs that were installed using Installation Manager before
modifying.

Note: You cannot modify the Eclipse location or JVM .

To modify an installed package:

1. From the main panel of Installation Manager, click the Modify Packages icon.
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On the Modify Packages panel, select the package group that contains the
packages you want to modify. If you need help determining what packages are
installed, see [“Determining what is currently installed on your system” on page|
Click Next to continue.

On the Languages panel, select or deselect any languages you want to add or
remove and click Next.

On the Features panel, the currently installed features are preselected. Select
any additional features you wish to install, or deselect any of the installed
features to remove them. When you have finished making your selections, click
Next to continue.

On the Summary panel, review your choices before you begin modifying your
installation. If you want to change the choices you made on previous panels,
click Back and make your changes. When you are satisfied with your choices,
Click Modify to make the changes you specified. The modification process
begins and a progress indicator shows you the percentage of the process
completed.

The Complete page is displayed with results.
Click View Log File to see the complete installation log.

Updating IBM Rational Developer for System z
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You can use IBM Installation Manager to install product updates and new features
for any packages that were installed by Installation Manager.

By default, Internet access is required to install updates unless your repository
preferences point to a local or network update repository to which your system has
access.. See the Installation Manager help for more information.

Note: Close all programs that were installed using Installation Manager before

updating.

To find and install package updates:

1.
2.

From the main panel of the Installation Manager, click Check for Updates.

On the Check for Updates panel, select the package group that contains the
packages you want to modify. If you need help determining what packages are
installed, see [“Determining what is currently installed on your system” on page|
If you want to check and update all the packages, select the Update All
check box. Click Next to continue.

Installation Manager searches the specified repository for any available
updates to the installed packages. The next panel displays a list of available
updates that were found.

By default, only the recommended updates are displayed. If you want to see all

the updates for the package, click Show All. The updates are displayed with

the required dependencies preselected.

Select the updates that you want to install and click Next.

On the Licenses panel, read the license agreements for the selected updates.

There will be a license agreement for each update you selected to install. On

the left side of the License panel, click each package name to display its license

agreement.

a. If you agree to the terms of all of the license agreements, click I accept the
terms of the license agreements.

b. Click Next to continue.
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7. On the Summary panel, review your choices before you begin installing the
updates. If you want to change the choices you made on previous panels, click
Back and make your changes. When you are satisfied with your installation
choices, click Update to install the update. The update installation begins and a
progress indicator shows you the percentage of the installation completed.

8. The Complete page is displayed with results.
9. Click View Log File link to see the complete installation log.

Uninstalling IBM Rational Developer for System z

The Uninstall option in the Installation Manager allows you to uninstall packages
that were previously installed using Installation Manager.

To uninstall the packages, you must log in to the system using the same user
account that you used to install the packages. Do one of the following to begin the
uninstall process:

¢ From the Windows Add or Remove Programs screen, select IBM Rational
Developer for System z (package group name) and click Remove. This launches
IBM Installation Manager.

¢ From the Windows Start menu, click Start -> All Programs -> IBM Installation
Manager -> IBM Installation Manager

1. Close all programs that you installed using Installation Manager.
2. From the main panel of Installation Manager, click Uninstall Packages.

3. On the Uninstall Packages panel, select the packages you want to uninstall.
Click Next.

4. In the Packages page, select the packages you want to uninstall and click Next.

5. On the Summary panel, review the packages you selected to uninstall. Click
Back if you want to make any changes. Click Uninstall to begin the uninstall
process.

6. The Complete panel is displayed after the uninstallation finishes and shows the
results.

7. Click Done.

Installing additional software

The following additional software is included with IBM Rational Developer for
System z:

Installing required System z server tools

See the Developer for System z Host Planning Guide for details on installing required
System z server tools.

Installing IBM TxSeries for Multiplatforms

CICS(R) TxSeries for Multiplatforms provides a local CICS development platform
so you can develop CICS programs.

CICS TxSeries has its own set of installation documentation, which is available on
the disk with the product.
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Installing IBM WebSphere Host Access Transformation Services
(HATS)

With HATS, you can create Web and rich client applications that provide an
easy-to-use graphical user interface (GUI) for your character-based 3270 and 5250
host applications.

HATS has its own set of installation documentation, which is available on the disk
with the product.

Known problems and limitations
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This section covers known problems and limitations with installation and
uninstallation.

For information about product problems and limitations, refer to the readme.htm]
file located in the Documents\en directory of the CD IBM Rational Developer for
System z and IBM Rational Application Developer Installation CD 1.

To search for updates to Developer for System z, do the following;:

1. Start the IBM Installation Manager from the Start menu (Programs -> IBM
Installation Manager -> IBM Installation Manager)

2. Click "Check for Updates” on the Quick Start panel.

3. Select the desired updates from the list of available updates and follow the
instructions on the screen to install.

Starting Rational Developer 7.1 from the final installation
panel causes TPFSHARE environment variable error

* When you install Rational Application Developer and Developer for System z at
the same time, the Complete panel at the end of the installation provides the
option of launching the Rational Application Developer product after you click
Finish. Developer for System z requires that you click Finish and exit IBM
Installation Manager before you start the product for the first time. If you start
the product from the final installation panel, you will see an error message when
the product starts indicating the TPFSHARE environment variable is not set. To
avoid this error, do the following:

1. On the final installation panel, do not click Launch Rational Application
Developer. Instead, click None.

2. Click Finish.

3. Start the IBM Rational Developer for System z product from the Windows
Start menu. Select Start > All Programs > [Package Group Name] > IBM
Rational Developer for System z > IBM Rational Developer for System z

If you do launch the product from the final installation panel and you see an
error message about a missing TPFSHARE environment variable, shut down the
product immediately and restart it from the Windows Start menu. Select Start >
All Programs > [Package Group Name] > IBM Rational Developer for System
z > IBM Rational Developer for System z .

If you continue to see the error message about a missing TPFSHARE environment
variable even after restarting the product, restart the product again using a new
workspace.
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IBM WebSphere Developer for zSeries Version 6.0.1 and IBM
Rational Developer for System z Version 7.1 workspace
incompatibility

* Workspaces used with Rational Developer for System z 7.1 are not compatible
with WebSphere Developer for zSeries 6.0.1. If you start Rational Developer for
System z 7.1 using a workspace from WebSphere Developer for zSeries 6.0.1,
your workspace will be migrated to work with Rational Developer for System z
7.1. If you plan to uninstall the Rational Developer for System z 7.1 update and
continue to use any WebSphere Developer for zSeries 6.0.1 workspace, you
should back up your WebSphere Developer for zSeries 6.0.1 workspaces before
installing Rational Developer for System z.

User authorization

When you install the product, you may receive a warning message if you are not
an Administrator. The message indicates that some programs may not work
correctly if they are not installed by an Administrator. You should log on as an
Administrator before beginning the Developer for System z installation.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS”
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

P.O. Box 12195, Dept. TL3B/B503/B313
3039 Cornwallis Rd.

Research Triangle Park, NC 27709-2195
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrates programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM’s application programming interfaces.
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Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights
reserved.

Programming interface information

Programming interface information is intended to help you create application
software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.

However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks and service marks

The following terms are trademarks or registered trademarks of International
Business Machines Corporation in the United States, or other countries, or both:

« AFS®

. AIX®

* CICS

* DB2

+ DB2 Extenders'
+ DB2 Universal Database™
* IBM

* IMS

+ MVS™

« 0S/390°

+ 0S/400°

¢ Passport Advantage

+ 5/390°

e System z

M

* VisualAge®
* WebSphere
e System z
* zSeries®

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States and other countries.

Microsoft, Windows, Windows NT®, and the Windows logo are trademarks or

registered trademarks of Microsoft Corporation in the United States, or other
countries, or both.
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UNIX® is a registered trademark of The Open Group

®

Linux” is a registered trademark of Linus Torvalds.

Rational are trademarks of International Business Machines Corporation and
Rational Software Corporation®, in the United States, other countries, or both.

Intel® and Pentium® are trademarks of Intel Corporation in the United States, or
other countries, or both.

Other company, product, and service names, which may be denoted by a double
asterisk(**), may be trademarks or service marks of others.
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Readers’ Comments — We’d Like to Hear from You

IBM Rational Developer for System z
Installation Guide
Version 7.1

Publication No. GI11-8297-00

We appreciate your comments about this publication. Please comment on specific errors or omissions, accuracy,
organization, subject matter, or completeness of this book. The comments you send should pertain to only the
information in this manual or product and the way in which the information is presented.

For technical questions and information about products and prices, please contact your IBM branch office, your
IBM business partner, or your authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any
way it believes appropriate without incurring any obligation to you. IBM or any other organizations will only use
the personal information that you supply to contact you about the issues that you state on this form.

Comments:

Thank you for your support.

Submit your comments using one of these channels:

* Send your comments to the address on the reverse side of this form.
* Send a fax to the following number: 1-800-227-5088(US and Canada)
* Send your comments via e-mail to: kfrye@us.ibm.com

If you would like a response from IBM, please fill in the following information:

Name Address

Company or Organization

Phone No. E-mail address
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